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cells alongside the completed solution and compare your result with the provided 

solution to ensure your success.  

The book has been organized around 11 topical areas.

Part I: Using Excel to Summarize Marketing Data
This part of the book introduces the marketing analyst to many Excel tools that 

can be used to analyze marketing problems: PivotTables (Chapter 1), charting 

(Chapter 2), and Excel statistical functions (Chapter 3), including the incredibly 

useful COUNTIF, COUNTIFS, SUMIF, SUMIFS, AVERAGEIF, and AVERAGEIFS functions.

Part II: Pricing
The determination of a profi t maximizing pricing strategy is always diffi  cult. In this 

section you learn how to quickly estimate demand curves and use the Excel Solver 

(Chapter 4) to determine profi t maximizing prices. The Excel Solver is then used to 

optimize price bundling (Chapter 5), nonlinear pricing strategies (Chapter 6), and 

price-skimming strategies (Chapter 7). A brief introduction to revenue management, 

also known as yield management (Chapter 8), is also included.

Part III: Forecasting
Businesses need accurate forecasts of future sales. Sales forecasts drive decisions 

involving production schedules, inventory management, manpower planning, and 

many other parts of the business. In this section you fi rst learn about two of the 

most used forecasting tools: simple linear (Chapter 9) and simple multiple regres-

sion (Chapters 10 and 11). Then you learn how to estimate the trend and seasonal 

aspects of sales (Chapter 12) and generate forecasts using two common extrapola-

tion forecasting methods: the Ratio to Moving Average method (Chapter 13), and 

Winter’s Method for exponential smoothing (Chapter 14) with trend and seasonality. 

Then you learn about neural networks (Chapter 15), a form of artifi cial intelligence 

whose role in marketing forecasting is rapidly growing.

Part IV: What Do Customers Want?
Every brand manager wants to know how various product attributes drive the 

sales of a product. For example, what is most important in a consumer’s choice of 

car: price, brand, engine horsepower, styling, or fuel economy? In this section you 

learn how conjoint analysis (Chapter 16) and discrete choice (Chapter 18) can be 

used to rank the importance of product attributes and also rank levels of product 

attributes. For example, what type of styling on an SUV is most preferred? You also 



How This Book Is Organized xxv

    

learn about the widely used tool of logistic regression (Chapter 17), which is used to 

estimate probabilities involving situations in which two, or binary, outcomes must 

be forecasted. For example, how a person’s demographic information can be used 

to predict the chance that he will subscribe to a magazine.

Part V: Customer Value
Companies cannot make intelligent decisions on how to spend money acquiring 

customers unless they understand the value of their customers. After all, spending 

$400 to acquire a customer who will generate $300 in long-term profi ts is a sure 

recipe for going out of business. In this section you learn how to measure customer 

value (Chapter 19), value companies based on the customer value concept (Chapter 

20), incorporate uncertainty in customer value models (Chapter 21), and use your 

understanding of customer value to optimally allocate resources (Chapter 22) between 

acquisition and retention of customers.

Part VI: Market Segmentation
No matter what product you sell, your market consists of diff erent market segments. 

For example, in Chapter 23 you will use cluster analysis to show that that every 

U.S. city can be classifi ed into one of four demographic segments. In Chapter 25 

you will learn how classifi cation trees can be used to segment a market. You are 

also introduced to the exciting concepts behind collaborative fi ltering (Chapter 24), 

which is the basis for Amazon.com and Netfl ix recommendations.

Part VII: Forecasting New Product Sales
With little or no history about sales of a product, it is diffi  cult to predict future prod-

uct sales. Given a few data points, S curves (Chapter 26) can be used to predict future 

product sales. The famous Bass diff usion model (Chapter 27) explains how sales 

of products evolve over time and can be used to predict product sales even before a 

product comes to the market. The little-known Copernican Principle (Chapter 28) 

enables you to predict the remaining time for which a product will be sold.

Part VIII: Retailing
Analytic techniques can help retailers deal with many important issues. The con-

cepts of market basket analysis and lift (Chapter 29) help retailers derive a store 

layout that maximizes sales from complementary products. Recency, frequency, and 

monetary value analysis (Chapter 30) helps direct mailers maximize profi t from 

their mailings. The widely known SCAN*PRO (Chapter 31) model helps retailers 
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determine how factors such as seasonality, price, and promotions infl uence product 

sales. In Chapter 32 you learn how to use analytic techniques to determine optimal 

allocation of store space between products and also optimize the use of a corporate 

sales force. Finally in Chapter 33 you learn how to forecast total sales of a product 

from a few data points.

Part IX: Advertising
Department store owner John Wanamaker said, “Half the money I spend on advertis-

ing is wasted; the trouble is I don’t know which half.” In Chapter 34 you learn how 

John Wanamaker could have used the ADSTOCK model to measure the eff ectiveness 

of his advertising expenditures. In Chapter 35 you learn how to allocate ads between 

the available media outlets to maximize the eff ectiveness of ads. Chapter 36 deals 

with the math behind online ad auctions.

Part X: Marketing Research Tools
Often the marketing analyst must deal with data sets involving many variables. 

Principal components (Chapter 37) and Multidimensional Scaling (Chapter 38) 

enable the marketing analysts to reduce data sets involving many variables to a 

few easily understood variables. Often the marketing analyst must classify objects 

into one of several groups. Naive Bayes and discriminant analysis (Chapter 39) are 

great tools for developing classifi cation rules. When the marketing analyst wants 

to determine if a single factor or a pair of factors has a signifi cant eff ect on product 

sales, ANOVA (Chapter 40 and Chapter 41) is a useful tool.

Part XI: The Internet and Social Marketing
In the last 20 years, the Internet has turned our world upside down, and marketing 

is no exception. Social media such as Facebook and Twitter create many interest-

ing opportunities for the marketer, which require careful analysis. In Chapter 42 

you learn how the theory of networks sheds light on how you can identify people 

who are the key to spreading the word about your product. Chapter 43 discusses 

the math behind Malcom Gladwell’s bestselling book The Tipping Point (Back Bay 

Books, 2002). Chapter 44 discusses the math behind videos (such as the notorious 

“Gangnam Style”) going viral. Finally, in Chapter 45 you learn how text mining can 

be used to glean useful insight from Twitter, blogs, and Facebook posts.
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Figure 1-1: Hardware store data

Calculating the Percentage of Sales at Each Store
The fi rst step in creating a PivotTable is ensuring you have headings in the fi rst 

row of your data. Notice that Row 7 of the example data in the data worksheet has 

the headings Product, Month, Store, and Price. Because these are in place, you can 

begin creating your PivotTable. To do so, perform the following steps: 

 1. Place your cursor anywhere in the data cells on the data worksheet, and then 

click PivotTable in the Tables group on the Insert tab. Excel opens the Create 

PivotTable dialog box, as shown in Figure 1-2, and correctly guesses that the 

data is included in the range Y7:AB1333.

Figure 1-2: PivotTable Dialog Box
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NOTE If you select Use an External Data Source here, you could also refer to 

a database as a source for a PivotTable. In Exercise 14 at the end of the chapter 

you can practice creating PivotTables from data in diff erent worksheets or even 

diff erent workbooks.

 2. Click OK and you see the PivotTable Field List, as shown in Figure 1-3.

Figure 1-3: PivotTable Field List

 3. Fill in the PivotTable Field List by dragging the PivotTable headings 

or fields into the boxes or zones. You can choose from the following 

four zones: 

 ■ Row Labels: Fields dragged here are listed on the left side of the table 

in the order in which they are added to the box. In the current example, 

the Store field should be dragged to the Row Labels box so that data 

can be summarized by store.
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 ■ Column Labels: Fields dragged here have their values listed across 

the top row of the PivotTable. In the current example no fields exist 

in the Column Labels zone.

 ■ Values: Fields dragged here are summarized mathematically in the 

PivotTable. The Price field should be dragged to this zone. Excel tries 

to guess the type of calculation you want to perform on a field. In 

this example Excel guesses that you want all Prices to be summed. 

Because you want to compute total revenue, this is correct. If you want 

to change the method of calculation for a data field to an average, a 

count, or something else, simply double-click the data field or choose 

Value Field Settings. You learn how to use the Value Fields Setting 

command later in this section.

 ■ Report Filter: Beginning in Excel 2007, Report Filter is the new 

name for the Page Field area. For fields dragged to the Report Filter 

zone, you can easily pick any subset of the field values so that the 

PivotTable shows calculations based only on that subset. In Excel 

2010 or Excel 2013 you can use the exciting Slicers to select the sub-

set of fields used in PivotTable calculations. The use of the Report 

Filter and Slicers is shown in the “Report Filter and Slicers” section of 

this chapter.

NOTE To see the fi eld list, you need to be in a fi eld in the PivotTable. If you 

do not see the fi eld list, right-click any cell in the PivotTable, and select Show 

Field List.

Figure 1-4 shows the completed PivotTable Field List and the resulting PivotTable 

is shown in Figure 1-5 as well as on the FirstorePT worksheet.

Figure 1-5 shows the downtown store sold $4,985.50 worth of goods, and the 

uptown store sold $4,606.50 of goods. The total sales are $9592.

If you want a percentage breakdown of the sales by store, you need to change the 

way Excel displays data in the Values zone. To do this, perform these steps: 

 1. Right-click in the summarized data in the FirstStorePT worksheet and select 

Value Field Settings. 

 2. Select Show Values As and click the drop-down arrow on the right side of the 

dialog box. 

 3. Select the % of Column Total option, as shown in Figure 1-6.
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Figure 1-4: Completed PivotTable Field List

Figure 1-5: Completed PivotTable

Figure 1-6: Obtaining percentage breakdown by Store
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Figure 1-7 shows the resulting PivotTable with the new percentage break-

down by Store with 52 percent of the sales in the downtown store and 

48 percent in the uptown store. You can also see this in the revenue by store 

worksheet of the PARETO.xlsx fi le. 

NOTE If you want a PivotTable to incorporate a diff erent set of data, then under 

Options, you can select Change Data Source and select the new source data. To 

have a PivotTable incorporate changes in the original source data, simply right-

click and select Refresh. If you are going to add new data below the original data 

and you want the PivotTable to include the new data when you select Refresh, you 

should use the Excel Table feature discussed in Chapter 2, “Using Excel Charts to 

Summarize Marketing Data.”

Figure 1-7: Percentage breakdown by Store

Summarizing Revenue by Month
You can also use a PivotTable to break down the total revenue by month and cal-

culate the percentage of sales that occur during each month. To accomplish this, 

perform the following steps: 

 1. Return to the data worksheet and bring up the PivotTable Field List by choos-

ing Insert PivotTable.

 2. Drag the Month fi eld to the Row Labels zone and the Price fi eld to the Values 

zone. This gives the total sales by month. Because you also want a percentage 

breakdown of sales by month, drag the Price fi eld again to the Values zone. 

 3. As shown in Figure 1-8, right-click on the fi rst column in the Values zone 

and choose Value Field Settings; then choose the % of Column Total option. 

You now see the percentage monthly breakdown of revenue.

 4. Double-click the Column headings and change them to Percentage of Sales 

by Month and Total Revenue. 



Slicing and Dicing Marketing Data with PivotTables 9

   

 5. Finally, double-click again the Total Revenue Column; select Number 

Format, and choose the Currency option so the revenue is formatted 

in dollars.

Figure 1-8: Monthly percentage breakdown of Revenue

You can see that $845 worth of goods was sold in January and 8.81 percent of 

the sales were in January. Because the percentage of sales in each month is approxi-

mately 1/12 (8.33 percent), the stores exhibit little seasonality. Part III, “Forecasting 

Sales of Existing Products,” includes an extensive discussion of how to estimate 

seasonality and the importance of seasonality in marketing analytics.

Calculating Revenue for Each Product
Another important part of analyzing data includes determining the revenue gener-

ated by each product. To determine this for the example data, perform the following 

steps: 

 1. Return to the data worksheet and drag the Product fi eld to the Row Labels 

zone and the Price fi eld to the Values zone. 

 2. Double-click on the Price column, change the name of the Price column to 

Revenue, and then reformat the Revenue Column as Currency. 

 3. Click the drop-down arrow in cell A3 and select Sort A to Z so you can alpha-

betize the product list and obtain the PivotTable in the products worksheet, 

as shown in Figure 1-9.
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Figure 1-9: Sales by Product

You can now see the revenue that each product generated individually. For exam-

ple, Adhesive 1 generated $24 worth of revenue.

The Pareto 80–20 Principle
When slicing and dicing data you may encounter a situation in which you want to fi nd 

which set of products generates a certain percentage of total sales. The well-known 

Pareto 80–20 Principle states that for most companies 20 percent of their products 

generate around 80 percent of their sales. Other examples of the Pareto Principle 

include the following:

 ■ Twenty percent of the population has 80 percent of income.

 ■ Of all possible problems customers can have, 20 percent of the problems cause 

80 percent of all complaints.

To determine a percentage breakdown of sales by product, perform the follow-

ing steps: 

 1. Begin with the PivotTable in the products worksheet and click the drop-down 

arrow in cell A3.
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 2. Select Value Filters; then choose Top 10... 

 3. Change the settings, as shown in Figure 1-10, to choose the products generat-

ing 80 percent of the revenue.

Figure 1-10: Using Value Filters to select products generating 80% of sales

The resulting PivotTable appears in the Top 80% worksheet (see Figure 1-11) and 

shows that the six products displayed in Figure 1-11 are the smallest set of prod-

ucts generating at least 80 percent of the revenue. Therefore only 20 percent of the 

products (6 out of 30) are needed to generate 80 percent of the sales. 

NOTE By clicking the funnel you may clear our fi lters, if desired.

Figure 1-11: 6 Products Generate 80% of Revenue

The Report Filter and Slicers 
One helpful tool for analyzing data is the Report Filter and the exciting Excel 2010 and  

2013 Slicers Feature. Suppose you want to break down sales from the example data 

by month and store, but you feel showing the list of products in the Row or Column 

Labels zones would clutter the PivotTable. Instead, you can drag the Month fi eld to 

the Row Labels zone, the Store fi eld to the Column Labels zone, the Price fi eld to the 

Value zone, and the Product fi eld to the Report Filter zone. This yields the PivotTable 

in worksheet Report filter unfiltered, as shown in Figure 1-12.
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Figure 1-12: PivotTable used to illustrate Slicers

By clicking the drop-down arrow in the Report Filter, you can display 

the total revenue by Store and Month for any subset of products. For exam-

ple, if you select products Safety 1, Safety 7, and Adhesive 8, you can obtain 

the PivotTable in the Filtered with a slicer worksheet, as shown in 

Figure 1-13. You see here that during May, sales of these products downtown are 

$10.00 and uptown are $34.00.

Figure 1-13: PivotTable showing sales for Safety 1, Safety 7 and Adhesive 8
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As you can see from Figure 1-13, it is diffi  cult to know which products were used 

in the PivotTable calculations. The new Slicer feature in Excel 2010 and 2013 (see 

the Filtered with a slicer worksheet) remedies this problem. To use this tool 

perform the following steps: 

 1. Put your cursor in the PivotTable in the Filtered with a Slicer worksheet 

and select Slicer from the Insert tab. 

 2. Select Products from the dialog box that appears and you see a Slicer 

that enables you to select any subset of products (select a product and 

then hold down the Control Key to select another product) from a 

single column. 

 3. Click inside the Slicer and you will see Slicer Tools on the ribbon. After 

selecting the Buttons section from Slicer Tools change Columns to 5. Now 

the products show up in fi ve columns (see Figure 1-14). 

Figure 1-14: Slicer selection for sales of Safety 1, Safety 7 and Adhesive 8.

A Slicer provides sort of a “dashboard” to fi lter on subsets of items drawn from a 

PivotTable fi eld(s). The Slicer in the Filtered with a slicer worksheet makes it obvi-

ous that the calculations refer to Safety 1, Safety 7, and Adhesive 8. If you hold down 

the Control key, you can easily resize a Slicer.

NOTE If you double-click in a cell in a PivotTable, Excel drills down to the 

source data used for that cell’s calculations and places the source data in a sepa-

rate sheet. For example, if in the Report filtered unfiltered worksheet you 

double-click in the January downtown cell, you can obtain the source data in the 

worksheet January downtown, as shown in Figure 1-15.
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F6:F1099. The second argument of 2 in the formula ensures that a Monday is 

recorded as 1, a Tuesday as 2, and so on. In cell E5 you can enter the formula 

=VLOOKUP(F5,lookday,2) to transform the 1 in the weekday column to the actual 

word Monday, the 2 to Tuesday, and so on. The second argument lookday in the 

formula refers to the cell range A6:B12. 

NOTE To name this range lookday simply select the range and type lookday 

in the Name box (the box directly to the left of the Function Wizard) and press 

Enter. Naming a range ensures that Excel knows to use the range lookday in any 

function or formula containing lookday. 

The VLOOKUP function fi nds the value in cell F5 (2) in the fi rst column of the 

lookday range and replaces it with the value in the same row and second column of 

the lookday range (Tuesday.) Copying the formula =VLOOKUP(F5,lookday,2) from 

E5 to E6:E1099 gives you the day of the week for each observation. For example, 

on Friday, January 11, 2013, there was no promotion and 74 cakes, 50 pies, 645 

cookies, 100 smoothies, and 490 cups of coff ee were sold.

Now you will learn how to use PivotTables to summarize how La Petit Bakery’s 

sales are aff ected by the following:

 ■ Day of the week

 ■ Month of the year

 ■ An upward (or downward!) trend over time in sales

 ■ Promotions such as price cuts

Summarizing the Effect of the Day of the Week on 
Bakery Sales
La Petit Bakery wants to know how sales of their products vary with the day of the 

week. This will help them better plan production of their products.

In the day of week worksheet you can create a PivotTable that summarizes the 

average daily number of each product sold on each day of the week (see Figure 1-17). 

To create this PivotTable, perform the following steps: 

 1. Drag the daywk fi eld to the Row Labels zone and drag each product to the 

Values zone. 

 2. Double-click each product, and change the summary measure to Average. 

You’ll see, for example, that an average of 96.5 cakes was sold on Sunday.
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Figure 1-17: Daily breakdown of Product Sales

As the saying (originally attributed to Confucius) goes, “A picture is worth a 

thousand words.” If you click in a PivotTable and go up to the Options tab and 

select PivotChart, you can choose any of Excel’s chart options to summarize the 

data (Chapter 2, “Using Excel Charts to Summarize Marketing Data,” discusses 

Excel charting further). Figure 1-17 (see the Daily Breakdown worksheet) shows 

the fi rst Line option chart type. To change this, right-click any series in a chart. The 

example chart here shows that all products sell more on the weekend than during 

the week. In the lower left corner of the chart, you can fi lter to show data for any 

subset of weekdays you want.

Analyzing Product Seasonality
If product sales are approximately the same during each month, they do not exhibit 

seasonality. If, however, product sales are noticeably higher (or lower) than aver-

age during certain quarters, the product exhibits seasonality. From a marketing 

standpoint, you must determine the presence and magnitude of seasonality to more 

effi  ciently plan advertising, promotions, and manufacturing decisions and invest-

ments. Some real-life illustrations of seasonality include the following:
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 ■ Amazon’s fourth quarter revenues are approximately 33 percent higher than 

an average quarter. This is because of a spike in sales during Christmas.

 ■ Tech companies such as Microsoft and Cisco invariably have higher sales 

during the last month of each quarter and reach maximum sales during the 

last month of the fi scal year. This is because the sales force doesn’t get its 

bonuses unless it meets quarterly or end of year quotas.

To determine if La Petit Bakery products exhibit seasonality, you can perform 

the following steps: 

 1. Begin with your cursor anywhere in the data in the BakeryData.xlsx work-

book. From the Insert tab select PivotTable and the PivotTable Field List will 

appear. Drag the Date fi eld to the Row Labels zone and as before, drag each 

product to the Values zone and again change the entries in the Values zone 

to average sales for each product. 

 2. At fi rst you see sales for every day, but you actually want to group sales by 

month. To do this, put the cursor on any date, right-click, and choose Group. 

 3. To group the daily sales into monthly buckets, choose Months from the dialog 

box, as shown in Figure 1-18.

Figure 1-18: Grouping data by Month

 4. Now select PivotChart from the Options tab. After selecting the fi rst Line chart 

option you obtain the PivotChart and PivotTable, as shown in the monthly 

breakdown worksheet of the LaPetitBakery.xlsx fi le (see Figure 1-19).
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Figure 1-19: Monthly breakdown of Bakery Sales

This chart makes it clear that smoothie sales spike upward in the summer, but 

sales of other products exhibit little seasonality. In Part III of this book you can fi nd 

an extensive discussion of how to estimate seasonality.

Given the strong seasonality and corresponding uptick in smoothie 

sales, the bakery can probably “trim” advertising and promotions expendi-

tures for smoothies between April and August. On the other hand, to match 

the increased demand for smoothies, the bakery may want to guarantee 

the availability and delivery of the ingredients needed for making its smoothies. 

Similarly, if the increased demand places stress on the bakery’s capability to serve 

its customers, it may consider hiring extra workers during the summer months.

NOTE If you right-click any month and select Ungroup, you can undo the 

grouping and return to a display of the daily sales data.
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Analyzing the Trend in Bakery Sales
The owners of La Petit Bakery want to know if sales are improving. Looking at a 

graph of each product’s sales by month will not answer this question if seasonality is 

present. For example, Amazon.com has lower sales every January than the previous 

month due to Christmas. A better way to analyze this type of trend is to compute 

and chart average daily sales for each year. To perform this analysis, complete the 

following steps: 

 1. Put your cursor inside the data in the Data worksheet of the BakeryData

.xlsx fi le, create a PivotTable, and drag each product to the Values zone and 

again change the method of summary from Sum to Average. 

 2. Then drag the Date fi eld to the Row Labels zone, place the cursor on any 

date, and right-click Group and choose Years. You see a monthly summary 

of average daily sales for each Month and Year. 

 3. Drag the Date fi eld away from the Row Labels zone and you are left with the 

summary of product sales by year, as shown in Figure 1-20 (see the work in 

worksheet by Year). 

 4. As you did before, create a Line PivotChart. The chart shows sales for each 

product are trending upward, which is good news for the client.

Figure 1-20: Summary of Sales by Year
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The annual growth rates for products vary between 1.5 percent and 4.9 percent. 

Cake sales have grown at the fastest rate, but represent a small part of overall sales. 

Cookies and coff ee sales have grown more slowly, but represent a much larger per-

centage of revenues.

Analyzing the Effect of Promotions on Sales
To get a quick idea of how promotions aff ect sales, you can determine average sales 

for each product on the days you have promotions and compare the average on days 

with promotions to the days without promotions. To perform these computations 

keep the same fi elds in the Value zone as before, and drag the Promotion fi eld to 

the Row Labels zone. After creating a line PivotChart, you can obtain the results, 

as shown in Figure 1-21 (see the promotion worksheet).

Figure 1-21: Effect of Promotion on Sales

The chart makes it clear that sales are higher when you have a promotion. Before 

concluding, however, that promotions increase sales, you must “adjust” for other fac-

tors that might aff ect sales. For example, if all smoothie promotions occurred during 

summer days, seasonality would make the average sales of smoothies on promotions 

higher than days without promotions, even if promotions had no real eff ect on sales. 

Additional considerations for using promotions include costs; if the costs of the pro-

motions outweigh the benefi ts, then the promotion should not be undertaken. The 
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chart (see Figure 1-23 and the age worksheet) to summarize the age distribu-

tion of subscribers.

Figure 1-22: Demographic data for ESPN: The Magazine

You fi nd that most of the magazine’s subscribers are in the 18–37 age group. 

This knowledge can help ESPN fi nd TV shows to advertise that target the right age 

demographic.

Analyzing the Gender of Subscribers
You can also analyze the gender demographics of ESPN: The Magazine subscrib-

ers. This will help the analyst to effi  ciently spend available ad dollars. After all, 

if all subscribers are male, you probably do not want to place an ad on Project 

Runway.

 1. In the data worksheet, drag the Gender fi eld to the Column Labels zone and 

the Gender fi eld to the Values zone. 

 2. Right-click the data and use Value Field Settings to change the calculations 

to Show Value As % of Row Total; this enables you to obtain the PivotTable 

shown in the gender worksheet (see Figure 1-24.)
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Figure 1-23: Age distribution of subscribers

Figure 1-24: Gender breakdown of subscribers

You fi nd that approximately 80 percent of subscribers are men, so ESPN may not 

want to advertise on The View!

Describing the Income Distribution of Subscribers
In the Income worksheet (see Figure 1-25) you see a breakdown of the percentage 

of subscribers in each income group. This can be determined by performing the 

following steps: 

 1. In the data worksheet drag the Income fi eld to the Row Labels zone and the 

Income fi eld to the Values zone. 
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 2. Change the Income fi eld in the Values zone to Count of Income (if it isn’t 

already there) and group incomes in $25,000 increments. 

 3. Finally, use Value Field Settings ➢ Show Value As ➢ % of Column Total to 

display the percentage of subscribers in each income bracket. 

You see that a majority of subscribers are in the $54,000–$103,000 range. In 

addition, more than 85 percent of ESPN: The Magazine subscribers have income 

levels well above the national median household income, making them an attractive 

audience for ESPN’s additional marketing eff orts.

Figure 1-25: Income distribution of subscribers

Describing Subscriber Location
Next you will determine the breakdown of ESPN: The Magazine subscribers between 

suburbs, urban, and rural areas. This will help the analyst recommend the TV sta-

tions where ads should be placed.

 1. Put your cursor inside the data from the data worksheet and drag the Location 

fi eld to the Column Labels zone and Value zone. 

 2. Apply Value Field Settings and choose Show Value As ➢ % of Row Total to 

obtain the PivotTable, as shown in the Location worksheet and Figure 1-26. 

You fi nd that 46 percent of subscribers live in the suburbs; 40 percent live in 

urban areas and 15 percent live in rural areas.

Figure 1-26: Breakdown of Subscriber Location
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the True Colors hardware store data in the products worksheet from the PARETO

.xlsx fi le. 

 1. With the cursor in any blank cell, type an = sign and point to the cell (B12) 

containing Adhesive 8 sales. 

 2. You will now see in the formerly blank cell the formul a =GETPIVOTDATA

("Price",$A$3,"Product","Adhesive 8"). Check your result against cell E10. 

This pulls the sales of Adhesive 8 ($42.00) from the PivotTable into cell E10.

This formula always picks out Adhesive 8 sales from the Price field in the 

PivotTable whose upper left corner is cell A3. Even if the set of products sold 

changes, this function still pulls Adhesive 8 sales. 

In Excel 2010 or 2013 if you want to be able to click in a PivotTable and return a 

cell reference rather than a GETPIVOTTABLE function, simply choose File ➢ Options, 

and from the Formulas dialog box uncheck the Use GetPivotData functions for the 

PivotTable References option (see Figure 1-28).

Figure 1-28: Example of GETPIVOTDATA function
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 c. Compute the fraction of station wagon purchasers that come from 

each of the following four categories: High Income Large Family, High 

Income Small Family, Low Income Large Family, and Low Income 

Small Family.

 3. The cranberrydata.xlsx fi le contains data for each quarter in the years 

2006–2011 detailing the pounds of cranberries sold by a small grocery store. 

You also see the store’s price and the price charged by the major competitor. 

Use this fi le to perform the following exercises: 

 a. Ignoring price, create a chart that displays the seasonality of cranberry 

sales.

 b. Ignoring price, create a chart that shows whether there is an upward 

trend in sales.

 c. Determine average sales per quarter, breaking it down based on whether 

your price was higher or lower than the competitor’s price.

 4. The tapedata.xlsx fi le contains data for weeks during 2009–2011 for the 

unit sales of 3M tape, price charged, whether an ad campaign was run that 

week (1 = ad campaign), and whether the product was displayed on the end 

of the aisle (1 = end cap). Use this fi le to perform the following exercises: 

 a. Does there appear to be an upward trend in sales?

 b. Analyze the nature of the monthly seasonality of tape sales.

 c. Does an ad campaign appear to increase sales?

 d. Does placing the tape in an end-cap display appear to increase sales?

 5. The fi les EAST.xlsx and WEST.xlsx contain information on product sales 

(products A–H) that you sell in January, February, and March. You want to 

use a PivotTable to summarize this sales data. The Field List discussed in 

this chapter does not enable you to create PivotTables on data from multiple 

ranges. If you hold down the ALT key and let go and hold down the D key 

and let go of the D key and hold down the P key, you can see the Classic 

PivotTable Wizard that enables you to select multiple ranges of data to key a 

PivotTable. Let Excel create a single page fi eld for you and create a PivotTable 

to summarize total sales in the East and West during each month. Use the 

Filters so that the PivotTable shows only January and March sales of products 

A, C, and E.





Part I: Using Excel to Summarizing Marketing Data30

   

All work for this chapter is located in the fi le Chapter2charts.xlsx. In the work-

sheet Combinations you see actual and target sales for the months January through 

July. To begin charting each month’s actual and target sales, select the range F5:H12 

and choose a line chart from the Insert tab. This yields a chart with both actual 

and target sales displayed as lines. This is the second chart shown in Figure 2-1; 

however, it is diffi  cult to see the diff erence between the two lines here. You can 

avoid this by changing the format of one of the lines to a column graph. To do so, 

perform the following steps: 

 1. Select the Target sales series line in the line graph by moving the cursor to 

any point in this series. 

 2. Then right-click, and choose Change Series Chart Type... 

 3. Select the first Column option and you obtain the first chart shown in 

Figure 2-1. 

Figure 2-1: Combination chart
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With the fi rst chart, it is now easy to distinguish between the Actual and Target 

sales for each month. A chart like this with multiple types of graphs is called a 

 combination chart.

You’ll likely come across a situation in which you want to graph two series, but 

two series diff er greatly in magnitude, so using the same vertical axis for each 

series results in one series being barely visible. In this case you need to include 

a secondary axis for one of the series. When you choose a secondary axis for a 

series Excel tries to scale the values of the axis to be consistent with the data 

values for that series. To illustrate the creation of a secondary axis, use the data 

in the Secondary Axis worksheet. This worksheet gives you monthly revenue 

and units sold for a company that sells expensive diamonds.

Because diamonds are expensive, naturally the monthly revenue is much larger 

than the units sold. This makes it diffi  cult to see both revenue and units sold with 

only a single vertical axis. You can use a secondary axis here to more clearly sum-

marize the monthly units sold and revenue earned. To do so, perform the following 

steps: 

 1. In the Secondary Axis worksheet select D7:F16, click the Insert tab, click 

the Line menu in the Charts section, and select the fi rst Line chart option. 

You obtain the chart shown in Figure 2-2.

Figure 2-2: Line graph shows need for Secondary Axis

 2. You cannot see the units’ data though, because it is so small relative to the 

revenue. To remedy this problem, select the Revenue series line in the graph 

and right-click.
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 3. Choose Format Data Series, and select Secondary Axis.

 4. Then select any point in the Revenue series, right-click, and change the chart 

type for the Revenue series to a column graph. 

The resulting chart is shown in Figure 2-3, and you can now easily see how closely 

units and revenue move together. This occurs because Revenue=Average price*units 

sold, and if the average price during each month is constant, the revenue and units 

sold series will move in tandem. Your chart indeed indicates that average price is 

consistent for the charted data.

Figure 2-3: Chart with a secondary axis

Adding Bling to a Column Graph with a Picture 
of Your Product
While column graphs are quite useful for analyzing data, they tend to grow dull day 

after day. Every once in a while, perhaps in a big presentation to a potential client, 

you might want to spice up a column graph here and there. For instance, in a column 

graph of your company’s sales you could add a picture of your company’s product 

to represent sales. Therefore if you sell Ferraris, you could use a .bmp image of a 

Ferrari in place of a bar to represent sales. To do this, perform the following steps:

 1. Create a Column graph using the data in the Picture worksheet. This data 

shows monthly sales of cars at an L.A. Ferrari dealer. 
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 2. After creating a Column graph, right-click on any column and choose Format 

Data Series... followed by Fill. 

 3. Click Picture or texture fi ll, as shown in Figure 2-4.

 4. Next click File below the Insert from query and choose the Ferrari

.bmp fi le (available for download from the companion site). 

 5. Choose Stack and Scale with 200 units per picture. This ensures each car 

represents sales of 200 cars. 

The resulting chart is shown in Figure 2-5, as well as in the Picture worksheet.

Figure 2-4: Dialog box for creating picture graph

NOTE If you choose Stretch in the Fill tab of the Format Data Series dialog, you 

can ensure that Excel represents each month’s sales by a single car whose size is 

proportional to that month’s sales.
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Figure 2-5: Ferrari picture graph

Adding Labels or Tables to Your Charts
Often you want to add data labels or a table to a graph to indicate the numerical 

values being graphed. You can learn to do this by using example data that shows 

monthly sales of product lines at the True Color Department Store. Refer to the 

Labels and Tables worksheet for this section’s examples. 

To begin adding labels to a graph, perform the following steps: 

 1. Select the data range C5:D9 and choose the first Column chart option 

(Clustered Column) from the Charts section of the Insert tab.

 2. Now click on any column in the graph and choose Layout from the Chart 

Tools section of the ribbon. 
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 3. Choose the Data Labels option from the Layout section of Chart Tools 

and select More Data Label Options... Fill in the dialog boxes as shown in 

Figure 2-6. 

 4. Include the Value and Category Name in the label, and put them on a diff er-

ent line.

The resulting graph with data labels is shown in Figure 2-7.

Figure 2-6: Dialog Box for creating chart with data labels

You can also add a Data Table to a column graph. To do so, again select any of 

the columns within the graph and perform the following steps: 

 1. From the Chart Tools tab, select Layout. 

 2. Choose Data Table.

 3. Choose the Show Data Table option to create the table shown in the second 

chart in Figure 2-7.
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Figure 2-8: Data for PivotChart example

To summarize this data, you can perform the following steps: 

 1. Select the data from the Survey Data worksheet and from the Tables section 

of the Insert tab choose PivotTable ➢ PivotTable and click OK. 

 2. Next drag the Question fi eld heading to the Row Labels zone and the Response 

fi eld heading to the Column Labels and Values zones. 

 3. Assume you want to chart the fraction of 1, 2, 3, 4, and 5 responses for each 

question. Therefore, use Value Field Settings to change the Summarize Values 

By tab fi eld to Count and change the Show Values As tab fi eld to % of Row 

Total. You then obtain the PivotTable shown fi rst in Figure 2-9. 

 4. You can now create a Pivot Chart from this table. Select PivotChart from the 

Options tab and choose the fi rst Column chart option. This process yields 

the PivotChart shown second in Figure 2-9. 

 5. This chart is a bit cluttered however, so click the drop-down arrow by the 

Question button, and choose to display only responses to Likely to Buy 

and Recommend to a Friend. The resulting uncluttered chart is shown in 

Figure 2-10. 
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Figure 2-9: PivotTable and cluttered PivotChart

Figure 2-10: Uncluttered PivotChart

You can see that for both questions more than 60 percent of the potential custom-

ers gave the new product a 4 or 5, which is quite encouraging.
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 3. Choose the Left Column. Now, for example, when you use the name Year1sales 

in a formula, Excel knows you are referring to D2. 

NOTE A important reason for using range names is the fact that you can use the 

F3 key to Paste Range Names in formulas. This can save you a lot of time moving 

back and forth in your spreadsheet. For example, if your data is in Column A and 

you have named it you can use the F3 key to quickly and easily paste the data into 

a formula that is far away from Column A (for example, Column HZ.)

You can continue by graphing the annual sales that are based on initial sales 

and annual sales growth. As these assumptions change, the graph title and 

vertical axis legend need to reflect those changes. To accomplish this goal 

proceed as follows:

 4. Enter the Year 1 sales in cell F5 with the formula =Year1sales. Copy the 

formula =F5*(1+anngrowth) from F6 to F7:F15 to generate sales in Years 

2–11. 

 5. You want to fi nd the year in which you break even, so copy the formula 

=IF(F5>=target,"yes","no") from G5 to G6:G15 to determine if you have 

broken even during the current year. For example, you can see that during 

Years 5–11 you broke even. 

The key to creating dynamic labels that depend on your assumed initial sales and 

annual sales growth is to base your chart title and series legend key off  formulas 

that update as your spreadsheet changes.

Now you need to determine the fi rst year in which you broke even. This 

requires the use of the Excel MATCH function. The MATCH function has the fol-

lowing syntax: MATCH(lookup_value,lookup_range,0). The lookup_range must 

be a row or column, and the MATCH function will return the position of the fi rst 

occurrence of the lookup_value in the lookup_range. If the lookup_value does 

not occur in the lookup_range, the MATCH function returns an #N/A error. The 

last argument of 0 is necessary for the MATCH function to work properly.

In cell E19 the formula =MATCH("yes",G5:G15,0) returns the fi rst year (in this 

case 5) in which you meet the breakeven target. In cell D22 several Excel functions 

are used to create the text string that will be the dynamic chart title. The formula 

entered in cell D22 is as follows:

=IFERROR("We will break even in year "&TEXT(E19,"0"),"Never break 
even")
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The functions used in this formula include the following:

 ■ IFERROR evaluates the formula before the comma. If the formula does not 

evaluate to an error, IFERROR returns the formula’s result. If the formula 

evaluates to an error, IFERROR returns what comes after the comma. 

 ■ The & or concatenate sign combines what is before the & sign with what 

comes after the & sign.

 ■ The TEXT function converts the contents of a cell to text in the desired format. 

The two most commonly used formats are “0”, which that indicates an integer 

format, and “0.0%”, which indicates a percentage format.

If the MATCH formula in cell E19 does not return an error, the formula in cell D22 

returns the text string We Will Break Even in Year followed by the fi rst year you 

break even. If you never make it to break even, the formula returns the phrase Never 

Break Even. This is exactly the chart title you need.

You also need to create a title for the sales data that includes the annual sales 

growth rate. The series title is created in cell D23 with the following formula:

="Sales (growth rate="&TEXT(anngrowth,"0.0")&")".

NOTE Note that the growth rate has been changed to a single decimal.

Now you are ready to create the chart with dynamic labels. To do so, perform 

the following steps:

 1. Select the source data (cell range E4:F15 in the Dynamic Labels worksheet) 

from the chart.

 2. Navigate to the Insert tab and choose an X-Y Scatter Chart (the second option). 

 3. Go to the Layout section of the Chart Tools Group and select Chart Title and 

Centered Overlay Chart.

 4. Place the cursor in the formula bar and type an equal sign (=), point to the 

chart title in D22, and press Enter. You now have a dynamic chart title that 

depends on your sales assumptions.

 5. To create the series title, right-click any plotted data point, and choose Select 

Data. 

 6. Click Edit and choose Series name. 





Part I: Using Excel to Summarizing Marketing Data44

   

Figure 2-14: Monthly sales data

Figure 2-15: Icon sets created with Wingdings 3 font

To begin creating up, down, or fl at arrows that refl ect monthly changes in each 

salesperson’s performance, perform the following steps: 

 1. Create each salesperson’s rank during each month by copying the formula 

=RANK(E6,E$6:E$20,0) from J6 to J6:N20.
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did not show the sales of every product. Check boxes make it easy to control which 

series show up in a chart. To create a check box, perform the following steps: 

 1. Ensure you see the Developer tab on the ribbon. If you do not see the Developer 

tab in Excel 2010 or 2013, select File ➢ Options, and from Customize Ribbon 

select the Developer tab. 

 2. To place a check box in a worksheet, select the Developer tab and chose Insert. 

 3. From the Form Controls (Not ActiveX) select the check box that is third from 

the left in the top row.

 4. After releasing the left mouse in the worksheet, you see a drawing tool. Hold 

down the left mouse to size the check box. If you want to resize the check 

box again later, simply hold down the control key and click the check box. 

A check box simply puts a TRUE or FALSE in a cell of your choosing. It serves 

as a Toggle switch that can be used to turn Excel features (such as a Function 

argument or Conditional Formatting) on or off. 

 5. Next, select the cell controlled by the check box by moving the cursor to the 

check box until you see the Pointer (a hand with a pointing fi nger). 

 6. Right-click, select the Format Control dialog box, and select cell F3 (by point-

ing) as the cell link. Click OK. 

 7. Now when this check box is selected, F3 shows TRUE, and when the check 

box is not selected, cell F3 shows FALSE. Label this check box with the name 

of the series it controls, Chocolate in this case. 

In a similar fashion four more check boxes were created that control G3, H3, I3, 

and J3. These check boxes control the DVDs, magazines, sodas, and hot dogs series, 

respectively. Figure 2-17 shows these check boxes.

After you have created the necessary check boxes, the trick is to not chart the 

original data but chart data controlled by the check boxes. The key idea is that Excel 

will ignore a cell containing an #N/A error when charting. To get started, copy the 

formula = IF(F$3,F6,NA()) from O6 to O6:S35 to ensure that a series will only be 

charted when its check box is checked. For instance, check the Chocolate check box 

and a TRUE appears in F3, so O6 just picks up the actual week 1 chocolate sales 

in F6. If you uncheck the Chocolate check box, you get a FALSE in F3, O6 returns 

#N/A, and nothing shows up in the chart. To chart the data in question, select the 

modifi ed data in the range O5:S35 and choose from the Insert tab the second X Y 

Scatter option. If you check only the Chocolate and Magazines check boxes, you 
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can obtain the chart shown in Figure 2-18, which shows only sales of Chocolate 

and Magazines.

Figure 2-17: Check boxes for controlling which products show in chart

Figure 2-18: Charting only selected data
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You can summarize the daily sales by graphing the daily counts for each city in 

a single cell. To do so, perform the following steps: 

 1. First, select where you want your Sparklines to go (the Sparklines worksheet 

uses K4:K14: you can use L4:L14) and then from the Insert tab, select Line 

from the Sparklines section.

 2. Fill in the dialog box shown in Figure 2-20 with the data range on which the 

Sparklines are based (D4:J14). 

Figure 2-20: Sparkline dialog box

You now see a line graph (refer to Figure 2-19) that summarizes the daily sales in 

each city. The Sparklines make it clear that Saturday is the busiest day of the week.

If you click in any cell containing a Sparkline, the Sparkline Tools Design tab 

appears. Here, after selecting the Design tab, you can make many changes to your 

Sparklines. For example, Figure 2-21 shows selections for the high and low points 

to be marked and Figure 2-22 shows the Sparklines resulting from these selections. 

Figure 2-21: Selecting High and Low Point Markers
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Figure 2-22: Sparklines with High and Low Markers

These Sparklines make it clear that Saturday was the busiest day for each branch 

and Monday was the slowest day.

The Design tab enables you to make the following changes to your Sparklines:

 ■ Alter the type of Sparkline (Line, Column, or Win-Loss). Column and Win-

Loss Sparklines are discussed later in the chapter.

 ■ Use the Edit Data choice to change the data used to create the Sparkline. You 

can also change the default setting so that hidden data is included in your 

Sparkline.

 ■ Select any combination of the high point, low point, negative points, fi rst 

point, or last point to be marked.

 ■ Change the style or color associated with the Sparklines and markers.

 ■ Use the Axis menu to change the way the axes are set for each Sparkline. For 

example, you may make the x-axis or y-axis scale the same for each Sparkline. 

This is the scaling used in the cell range K18:K28. Note this choice shows that 

Nashville, for example, sells fewer rings than the other cities. The default is 

for the scale for each axis to be based on the data for the individual Sparkline. 

This is the scaling used in the Sparklines in the cell range K4:K14 of Figure 

2-22. The Custom Value choice enables you to pick an upper and lower limit 

for each axis. 

 ■ When data points occur at irregularly spaced dates, you can select Data Axis 

Type from the Axis menu so that the graphed points are separated by an 

amount of space proportional to the diff erences in dates. 
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NOTE By clicking any of the Sparklines, you could change them to Column 

Sparklines simply by selecting Column from the Sparklines Design tab.

Excel also can create Win-Loss Sparklines. A Win-Loss Sparkline treats any 

positive number as an up block and any negative number as a down block. Any 0s 

are graphed as a gap. A Win-Loss Sparkline provides a perfect way to summarize 

performance against sales targets. In the range D32:J42 you can see a list of the 

daily targets for each city. By copying the formula = IF(D18>D32—1—1) from D45 to 

D45:J55, you can create a 1 when a target is met and a –1 when a target is not met. 

To create the Win-Loss Sparklines, select the range where the Sparklines should be 

placed (cell range K45:K55) and from the Insert menu, select Win-Loss Sparklines. 

Then choose the data range D45:J55. Figure 2-23 shows your Win-Loss Sparklines.

Figure 2-23: Win-Loss Sparklines

NOTE If you want your Sparklines to automatically update to include new data, 

you should make the data a table. 
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Figure 2-25: PivotTable for Weekly sales report

 3. Create a drop-down box in cell AG8 from which a store can be selected. To 

accomplish this, navigate to the Data tab and select Data Validation from the 

Data Tools group. 

 4. Choose Settings and fi ll in the Data Validation dialog box, as shown in Figure 

2-26. This ensures that when the cursor is placed in cell AG8 you can see a 

drop-down box that lists the store names (pulled from cell range F5:F8)

Figure 2-26: Creating Data Validation drop-down box

 5. Enter week numbers in the range AG11:AG24 and product categories in 

AG10:AK10. Then use the GETPIVOTDATA function to pull the needed data 

from the PivotTable. Before entering the key formula, simply click anywhere 

in the PivotTable to get a GETPIVOTDATA function. Then copy that function and 
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paste it in the following formula to modify the arguments for Week, Category, 

and Store, as shown here. Enter this important formula in cell AH11:

=IF(AH$9=FALSE,NA(),IFERROR(GETPIVOTDATA("Revenue",$I$11,"WEEK"
,$AG11,"Category",AH$10,"Store",$AG$8)," ")).

 6. Copy this formula to the range AH11:AK24. This formula uses GETPIVOTDATA 

to pull revenue for the store listed in AG8 and the category listed in row 10 

if row 9 has a TRUE. The use of IFERROR ensures a blank is entered if the 

category were not sold in the selected store during the given week. 

 7. Make the source data for the chart, AG10:AK24, a table, so new data is auto-

matically included in the graph. The Table feature can also ensure that when 

you enter a new week the GETPIVOTDATA formulas automatically copy down 

and pull needed information from the updated PivotTable.  

 8. Use check boxes to control the appearance of TRUE and FALSE in AH9:AK9. 

After making the range AG10:AK24 a table, the chart is simply an X-Y scatter 

graph with source data AG10:AK24. Figure 2-27 shows the result.

Figure 2-27: Sales summary report

 9. Now add new data for Week 15 and refresh the PivotTable. If you add Week 

15 in cell AG25, the graph automatically updates. Because you made the 

source data for the chart a table, when you press Enter Excel “knows” you 

want the formulas copied down.
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 3. The Pictures and Labels worksheet includes monthly tomato sales on 

Farmer Smith’s farm. Summarize this data with pictures of tomatoes, data 

labels, and a data table.

 4. The Survey worksheet contains results evaluating a training seminar for sales-

people. Use a PivotChart to summarize the evaluation data.

 5. The data in the checkboxes worksheet contains monthly sales during 2010 

and 2011. Use check boxes to set up a chart in which the user can choose 

which series are charted.

 6. The Income worksheet contains annual data on median income in each state 

for the years 1984–2010. Use Sparklines to summarize this data.

 7. Jack Welch’s GE performance evaluation system requires management to 

classify the top 20 percent of all workers, middle 70 percent of all workers, 

and bottom 10 percent of all workers. Use Icon sets to classify the salespeople 

in the Sales Tracker worksheet of fi le Chapter2data.xlsx according to the 

20-70-10 rule. 

NOTE You need the PERCENTILE  function. For example, the function 

PERCENTILE(A1:A50,.9) would return the 90th percentile of the data in the cell 

range A1:A50.

Exercises 8 and 9 deal with the data in the file LaPetitbakery.xlsx that was 

discussed in Chapter 1.

 8. Use the Excel Table feature to set up a chart of daily cake sales that updates 

automatically when new data is included.

 9. Set up a chart that can be customized to show total monthly sales for any 

subset of La Petit Bakery’s products. Of course, you want the chart to update 

automatically when new data appears in the worksheet.

 10. The marketing product life cycle postulates that sales of a new product will 

increase for a while and then decrease. Specify the following fi ve inputs:

 ■ Year 1 sales

 ■ Years of growth

 ■ Years of decline

 ■ Average annual growth rate during growth period

 ■ Average annual decline during decline period
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Set up a Data Validation drop-down box that allows years of growth and 

decline to vary between 3 and 10. Then determine sales during Years 1–20. 

Suppose 10,000 units need to be sold in a year to break even. Chart your 

annual sales, and set up a dynamic chart title that shows the year (if any) in 

which you break even. Your series label should include the values of the five 

input parameters.
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When using an array function, you need to observe the following rules:

 1. Select the range of cells that will be populated by the array function. 

Often an array function populates more than one cell, so this is important.

 2. Type in the function just like an ordinary formula.

 3. To complete the entry of the formula, do not just press Enter; instead press 

Control+Shift+Enter. This is called array entering a formula.

Because the FREQUENCY function is a rather diffi  cult array function, let’s begin 

with a discussion of a simpler array function, the TRANSPOSE function.

Using the TRANSPOSE Function
The TRANSPOSE function is a great place to start when illustrating the use of array 

functions. To begin, take a look at the Histogram worksheet in the Chapter3bakery.

xlsx fi le. In Figure 3-1, cells N27:Q27 list some of my best students. This list would 

be easier to digest though if the names were listed in a column. To do this, copy 

N27:Q27 and move the cursor to R28, then right-click and select Paste Special... 

Select the Transpose checkbox to paste the names in a column. 

Figure 3-1: Use of the Transpose function

Unfortunately, if you change the source data (for example, Scarlett to Blake) the 

transposed data in column R does not refl ect the change. If you want the transposed 

data to refl ect changes in the source data, you need to use the TRANSPOSE function. 

To do so perform the following steps: 

 1. Select S28:S31. 

 2. Enter in cell S28 the formula =TRANSPOSE(N27:Q27)  and press 

Control+Shift+Enter. You will know an array formula has been entered when 

you see a { in the Formula bar. 

 3. Change Scarlett in N27 to Blake, and you can see that Scarlett changes to 

Blake in S28 but not in R28.
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Using the FREQUENCY Function
The FREQUENCY function can be used to count how many values in a data set 

fit into various ranges. For example, given a list of heights of NBA basketball 

players the FREQUENCY function could be used to determine how many players 

are at least 7’ tall, how many players are between 6’ 10” and 7’ tall, and so on. The 

syntax of the FREQUENCY function is FREQUENCY(array,bin range). In this section 

you will utilize the FREQUENCY function to create a histogram that charts the num-

ber of days in which cake sales fall into diff erent numerical ranges. Moreover, your 

chart will automatically update to include new data.

On the Histogram worksheet you are given daily sales of cakes at La Petit Bakery. 

You can summarize this data with a histogram. The completed histogram is provided 

for you in the worksheet, but if you want to follow along with the steps simply copy 

the data in D7:E1102 to the same cell range in a blank worksheet. Begin by dividing 

a range of data into 5–15 equal size ranges (called a bin range) to key a histogram. 

To do so, perform the following steps: 

 1. Select your data (the range D7:E1102) and make this range a table by select-

ing Insert ➢ Table. If a cell range is already a table then under Insert the table 

option will be grayed out.

 2. In cell E5, point to all the data and compute the minimum daily cake sales 

with the formula =MIN(Table1[Cakes]). 

 3. Similarly, determine the maximum daily cake sales in E6. The range 

of daily cake sales is between 32 and 165. Select your bin ranges to be

<= 30, 31–50, 51–70, …, 151–170…, > 170 cakes. 

 4. List the boundaries for these bin ranges in the cell range I9:I17. 

Figure 3-2 shows this process in action.

You can now use the FREQUENCY function to count the number of days in 

which cake sales fall in each bin range. The syntax of the FREQUENCY function is 

FREQUENCY(array,bin range). When an array is entered, this formula can count 

how many values in the array range fall into the bins defi ned by the bin range. In 

this example the function will count the number of days in which cake sales fall 

in each bin range. This is exemplifi ed in Figure 3-2. To begin using the FREQUENCY 

function, perform the following steps: 

 1. Select the range J9:J17 in the Histogram worksheet and type the formula

=FREQUENCY(E8:E1102,I9:I17). 
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 2. Array enter this formula by pressing Control+Shift+Enter. This formula com-

putes how many numbers in the table are ≤30, between 31 and 50,…, between 

151 and 170, and more than 170. 

Figure 3-2: Dynamic histogram for cake sales

For example, you can find that there were three days in which between 151 

and 170 cakes were sold. The counts update automatically if new days of 

sales are added. 

 3. Select the range I9:J17, and from the Insert tab, select the fi rst Column Graph 

option. 

 4. Right-click any column, select Format Data Series..., and change Gap Width 

to 0. This enables you to obtain the histogram, as shown in Figure 3-2.

 5. If you enter more data in Column E (say 10 numbers >170) you can see that 

the histogram automatically updates to include the new data. This would not 

have happened if you had failed to make the data a Table.
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Skewness and Histogram Shapes
There are a variety of histograms that are seen when examining marketing data, 

but the three most commonly seen histogram shapes are listed here (see Figure 3-3 

and fi le Skewexamples.xlsx):

 ■ Symmetric histogram: A histogram is symmetric and looks approximately the 

same to the left of the peak and the right of the peak. In Figure 3-3 the IQ 

scores yield an asymmetric histogram.

 ■ Positively skewed: (skewed right) A histogram is positively skewed (or skewed 

right) if it has a single peak and the values of the data set extend much further 

to the right of the peak than to the left of the peak. In Figure 3-3 the histogram 

of family income is positively skewed.

 ■ Negatively skewed: (skewed left) A histogram is negatively skewed if it has a 

single peak and the values of the data set extend much further to the left of 

the peak than to the right of the peak. In Figure 3-3, the histogram of Days 

from Conception to Birth is negatively skewed.

Figure 3-3: Symmetric, positively skewed, and negatively skewed histograms
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number of that product sold in a day. Three measures are often used to summarize 

the typical value for a data set.

 ■ The mean, or average, is simply the sum of the numbers in the data set divided 

by the number of values in the dataset. The average is computed with the 

Excel AVERAGE function. For example, the average of the numbers 1, 3, and 5 

is 1+3+5

   3
 = 3. You can often use x to denote the mean or average of a data set.

 ■ The median is approximately the 50th percentile of the data set. Roughly one-

half the data is below the median and one-half the data is above the median. 

More precisely, suppose there are n values that when ordered from smallest 

to largest are x
1
, x

2
, …, x

n
. If n is odd the median is x

.5(n+1)
, and if n is even, the 

median is (x
.5n 

+ x
.5n+1

)/2 . For example, for the data set 1, 3, 5, the median is 

3, and for the data set 1, 2, 3, 4 the median is 2.5. The MEDIAN function can 

be used to compute the median for a data set.

 ■ The mode of a data set is simply the most frequently occurring value in 

the data set. If no value appears more than once, the data set has no mode. 

The MODE function can be used to compute the mode of a data set. A data 

set can have more than one mode. If you have Excel 2010 or later, then 

the array function MODE.mult (see Excel 2010 Data Analysis and Business 

Modeling by Wayne Winston [Microsoft Press, 2011]) can be used to 

compute all modes. For example, the data set 1, 3, and 5 has no mode, 

whereas the data set 1, 2, 2, 3 has a mode of 2.

The Descriptive stats worksheet uses Excel functions to compute three mea-

sures of typical value for daily sales of cakes, pies, cookies, smoothies, and coff ee. 

Complete the following steps and see Figure 3-4 for details. 

 1. To compute the average for daily cake sales in cell H5, enter the 

formula =AVERAGE(H12:H1106).

 2. To compute the median for daily cake sales in cell H6, enter the formula 

=MEDIAN(H12:H1106). 

 3. To, compute the mode of daily cake sales in cell H7, enter the formula 

=MODE(H12:H1106). 

 4. Copy these formulas to the range I5:L7 to compute these measures for La 

Petit Bakery’s other products.

You fi nd, for example, that on average 86.28 cakes were sold each day, around 

one-half the time fewer than 85 cakes were sold, and the most frequently occurring 

number of cakes sold in a day is 90.
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Figure 3-4: Descriptive statistics

Which Measure of Typical Value Is Best?
Although there is no single best answer to this question, there are a few rules of 

thumb that are summarized here. The mode might be relevant if a hat store wanted 

to maximize sales and was going to stock only one size of hats. In most cases, 

however, the analyst who wants to summarize a data set by a single number must 

choose either the mean or the median. In the presence of substantial positive or 

negative skewness, extreme values tend to distort the mean, and the median is a 

better choice as a summary of a typical data value. In other situations using the 

median throws out important information, so the mean should be used to sum-

marize a data set. To summarize: 

 ■ If a skew statistic is greater than 1 or less than –1, substantial skewness exists 

and you should use median as a measure of typical value.

 ■ If skew statistic is between –1 and 1, use mean as a measure of typical value.

For the cake example, data skewness is between –1 and 1, so you would use the 

mean of 86.28 cakes as a summary value for daily cake sales.



Using Excel Functions to Summarize Marketing Data 67

   

For an example of how skewness can distort the mean, consider the starting 

salaries of North Carolina students who graduated in 1984. Geography majors had 

by far the highest average starting salary. At virtually every other school, business 

majors had the highest average starting salary. You may guess that Michael Jordan 

was a UNC geography major, and his multimillion dollar salary greatly distorted 

the average salary for geography majors. The median salary at UNC in 1984 was, 

as expected, highest for business majors. 

Using the VAR and STDEV Functions to Summarize 
Variation
Knowledge of the typical value characterizing a data set is not enough to completely 

describe a data set. For example, suppose every week Customer 1 spends $40 on 

groceries and during a week Customer 2 is equally likely to spend $10, $20, $30, 

or $100 on groceries. Each customer spends an average of $40 per week on gro-

ceries but we are much less certain about the amount of money Customer 2 will 

spend on groceries during a week. For this reason, the description of a data set is 

not complete unless you can measure the spread of a data set about its mean. This 

section discusses how the variance and standard deviation can be used to measure 

the spread of a data set about its mean.

 Given a data set x
1
,x

2
, …, x

n
 the sample variance (s2) of a data set is approximately 

the average squared deviation of the mean and may be computed with the formula 

s2 =   1
n−1∑ i=1

i=n(x
i
 − x

)2. Here x is the average of the data values. For example, for the data 

set 1, 3, 5 the average is 3, so the sample variance is as follows: 

1

2
{(1 − 3)2 + (3 − 3)2 + (5 − 3)2} = 4

Note that if all data points are identical, then the sample variance is 0. You should 

square deviations from the mean to ensure that positive and negative deviations 

from the mean will not cancel each other out. 

Because variance is not in the same units as dollars, the analyst will 

usually take the square root of the sample variance to obtain the sample standard 

deviation(s). Because the data set 1, 3, and 5, has a sample variance of 4, s=2.

The Excel VAR function computes sample variance, and the Excel STDEV function 

computes sample standard deviation. As shown in Figure 3-4 (see Descriptive 

stats worksheet), copying the formula =STDEV(H12:H1106) from H8 to K8:L8 com-

putes the standard deviation of each product’s daily sales. For example, the standard 

deviation of daily cake sales was 20.28 cakes.
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The Rule of Thumb for Summarizing Data Sets
If a data set does not exhibit substantial skewness, then the statisticians’ interest-

ing and important rule of thumb lets you easily characterize a data set. This rule 

states the following:

 ■ Approximately 68 percent of all data points are within 1 sample standard 

deviation of the mean.

 ■ Approximately 95 percent of all data points are within 2 standard deviations 

(2s) of the mean.

 ■ Approximately 99.7 percent of the data points are within 3 standard devia-

tions of the mean.

Any data point that is more than two sample standard deviations (2s) from the 

mean is unusual and is called an outlier. Later in the chapter (see the “Verifying the 

Rule of Thumb” section) you can fi nd that for daily cake sales, the rule of thumb 

implies that 95 percent of all daily cake sales should be between 45.3 and 126.83. 

Thus cake sales less than 45 or greater than 127 would be an outlier. You can also 

fi nd that 95.62 percent of all daily cake sales are within 2s of the mean. This is in 

close agreement with the rule of thumb.

The Percentile.exc and Percentrank.exc Functions
A common reorder policy in a supply chain is to produce enough to have a low 

percent chance, say, a 5 percent, of running out of a product. For cakes, this would 

imply that you should produce x cakes, where there is a 5 percent chance demand 

for cakes that exceed x or a 95 percent chance demand for cakes that is less than 

or equal to x. The value x is defi ned to be the 95th percentile of cake demand. The 

Excel 2010 and later function PERCENTILE.EXC(range, k) (here k is between 0 and 

1) returns the 100*kth percentile for data in a range. In earlier versions of Excel, 

you should use the PERCENTILE function. By copying the formula =PERCENTILE.

EXC(H12:H1106,0.95) from H9 to I9:L9 of the Descriptive stats worksheet you 

can obtain the 95th percentile of daily sales for each product. For example, there is 

a 5 percent chance that more than 122 cakes will be sold in a day.

Sometimes you want to know how unusual an observation is. For example, on 

December 27, 2015, 136 cakes were sold. This is more than two standard devia-

tions above average daily cake sales, so this is an outlier or unusual observation. 

The PERCENTRANK.EXC function in Excel 2010 or later (or PERCENTRANK in earlier 

versions of Excel) gives the ranking of an observation relative to all values in a data 
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set. The syntax of PERCENTRANK.EXC is PERCENTRANK(range, x,[significance]). 

This returns the percentile rank (as a decimal) of x in the given range. Signifi cance 

is an optional argument that gives the number of decimal points returned by the 

function. Entering in cell H3 the formula =PERCENTRANK.EXC(H12:H1106,H1102), 

you fi nd that you sold more than 136 cakes on only 2.1 percent of all days.

The LARGE and SMALL Functions
Often you want to fi nd, say, the fi fth largest or third smallest value in an array. The 

function LARGE(range,k) returns the kth largest number in a range, whereas the 

function SMALL(range,k) returns the kth smallest number in a range. As shown 

in Figure 3-4, entering in cell H1 the formula =LARGE(H12:H1106,5) tells you the 

fi fth largest daily sales of cakes was 148. Similarly, entering in cell H2 the formula 

=SMALL(H12:H1106,3) tells you the third smallest daily demand for cakes was 38.

These same powerful statistical functions can be used by marketing managers 

to gain important insights such as who are the 5 percent most profitable 

customers, who are the three most costly customers, or even what percentage of 

customers are unprofi table.

Using the COUNTIF and SUMIF Functions
In addition to mathematical functions such as SUM and AVERAGE, the COUNTIF and 

SUMIF functions might be (or should be!) two of the most used functions by mar-

keting analysts. These functions provide powerful tools that enable the analyst 

to select a subset of data in a spreadsheet and perform a calculation (count, sum, 

or average) on any column in the spreadsheet. The wide variety of computations 

performed in this section should convince the marketer that these functions are a 

necessary part of your toolkit. 

The fi rst few examples involve the COUNTIF and SUMIF functions. The COUNTIF 

function has the syntax COUNTIF(range, criteria). Then the COUNTIF function 

counts how many cells in the range meet the criteria. The SUMIF function has the 

syntax SUMIF (range, criteria, and sum_range). Then the SUMIF function adds up 

the entries in the sumrange column for every row in which the cell in the range 

column meets the desired criteria. 

The following sections provide some examples of these functions in action. The 

examples deal with the La Petit Bakery data, and the work is in the Sumif Countif 

worksheet. The work is also shown in Figure 3-5. The Create From Selection feature 

(discussed in Chapter 2) is used in the examples to name columns F through O with 

their row 10 headings.
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Figure 3-5: Illustrating the Rule of Thumb

Counting the Number of Promotions
The Excel COUNTIF  function can be used to count the number of rows in 

a range of cells that meet a single criterion. For example, you can com-

pute the number of days on which La Petit Bakery had a promotion and did 

not have a promotion by using the COUNTIF function. Simply copy the for-

mula =COUNTIF(promotion,Q14) from R14 to R15. You will see that there were 

110 days with a promotion and 985 without a promotion. Note that Q14 as a 

criterion ensures that you only count days on which there was a promotion and Q15 

as a criterion ensures that you only count days on which there was no promotion.

Verifying the Rule of Thumb
In the “Rule of Thumb” section of this chapter you learned that the rule of thumb 

tells you that for approximately 95 percent of all days, cake sales should be within 

2s of the mean. You can use the COUNTIF function to check if this is the case. In 

cell G3 you can compute for daily cake sales the Average –2s with the formula 

AVERAGE(Cakes)−2*STDEV(Cakes). In G4 you can compute the Average +2s with 

the formula AVERAGE(Cakes)+2*STDEV(Cakes).

You can also fi nd the number of days (13) on which cakes were more than 2s 

below the mean. To do so, enter in cell H3 the formula COUNTIF(Cakes,"<"&G3). 

The & (or concatenate) sign combines with the less than sign (in quotes because < 

is text) to ensure you only count entries in the Cakes column that are more than 

2s (s = sample standard deviation) below the mean.

In cell H4 the formula COUNTIF(Cakes,">"&G4) computes the num-

ber of days (35) on which cake sales were more than 2s above the mean. Any 

data point that differs from the dataset’s mean by more than 2s is called an 

outlier. Chapters 10 and 11 will make extensive use of the concept of an outlier.
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The COUNT function can be used to count the number of numeric entries 

in a range while the COUNTA function can be used to count the number of non-

blanks in a range. Also the COUNTBLANK function counts the number of blank 

cells in a range. For example, the function =COUNT(Cakes) in cell G5 counts 

how many numbers appear in the Cake column (1095). The COUNTA func-

tion counts the number of nonblank (text or numbers) cells in a range, and the 

COUNTBLANK function counts the number of blanks in a range. In G6 compute 

(with formula =G5−H3−H4) the number of cells (1047) within 2s of the mean. In G7 

you fi nd that 95.62 percent of the days had cake cells within 2s of the mean. This is 

in close agreement with the rule of thumb.

Computing Average Daily Cake Sales
You can also use SUMIF and COUNTIF functions to calculate the average sales of cakes 

for each day of the week. To do so, perform the following steps: 

 1. Copy the formula =SUMIF(daywk,Q20,Cakes) from S20 to S21:S26 to compute 

the total cake sales for each day of the week.

 2. Copy the formula =COUNTIF(daywk,Q20) from R20 to R21:R:26 to compute 

for each day of the week the number of times the day of the week occurs in 

your data set.

 3. Finally, in Column T, divide the SUMIF result for each day by the COUNTIF 

result, and this gives the average cake sales for each day of the week. 

To rank the average cake sales for each day of the week, copy the formula 

=RANK(T20,$T$20:$T$26,0) from U20 to U21:U26. The formula in U20 ranks the 

Monday average sales among all days of the week. Dollar signing the range T20:T26 

ensures that when you copy the formula in U21, each day’s average sales is ranked 

against all 7 days of the week. If you had not dollar signed the range T20:T26, then 

in U21 the range would have changed to T21:T27, which would be incorrect because 

this range excludes Monday’s average sales. The last argument of 0 ensures that the 

day of the week with the largest sales is given a rank of 1. If you use a last argument of 

1, then sales are ranked on a basis that makes the smallest number have a rank of 1, 

which is not appropriate in this situation. Note that Saturday is the best day for sales 

and Wednesday was the worst day for sales.

In an identical manner, as shown in Figure 3-6 you can compute the average daily 

sales of smoothies during each month of the year in the cell range Q28:U40. The 

results show that the summer months (June–August) are the best for smoothie sales.
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Figure 3-6: Daily summary of cake sales

In the next section you will learn how the AVERAGEIF function makes these cal-

culations a bit simpler.

Using the COUNTIFS, SUMIFS, AVERAGEIF, and 
AVERAGEIFS Functions

COUNTIF and SUMIF functions are great, but they are limited to calculations 

based on a single criteria. The next few examples involve the use of four Excel 

functions that were fi rst introduced in Excel 2007: COUNTIFS, SUMIFS, AVERAGEIF, 

and AVERAGEIFS (see the New 2007 Functions worksheet). These functions enable 

you to do calculations involving multiple (up to 127!) criteria. A brief descrip-

tion of the syntax of these functions follows:

 ■ The syntax of COUNTIFS is COUNTIFS(range1,criteria1, range2,critieria2, 

.. range_n, criteria_n). COUNTIFS counts the number of rows in which 
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the range1 entry meets criteria1, the range2 entry meets criteria2, and … the 

range_n entry meets criteria_n.

 ■ The syntax of SUMIFS is SUMIFS(sum_range, range1, criteria1, range2, 

criteria2, …,range_n,criteria_n). SUMIFS sums up every entry in the 

sum_range for which criteria1 (based on range1), criteria2 (based on range2), 

… criteria_n (based on range_n) are all met.

 ■ The AVERAGEIF function has the syntax AVERAGEIF(range, criteria, 

average_range). AVERAGEIF averages the range of cells in the average range 

for which the entry in the range column meets the criteria.

 ■ The syntax of AVERAGEIFS is AVERAGEIFS(average_range, criteria_range1, 

criteria_range2, ..., criteria_range_n). AVERAGEIFS averages every entry 

in the average range for which criteria1 (based on range1), criteria2 (based 

on range2), … criteria_n (based on range_n) are all met.

Now you can use these powerful functions to perform many important compu-

tations. The following examples are shown in the New 2007 Functions worksheet. 

The work is shown in Figure 3-7.

Figure 3-7: Monthly sales summary
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Calculating the Number of Promotions on Each Day of the Week
In R3 the formula COUNTIFS(daywk,Q3,promotion,"promotion") counts the num-

ber of promotions (23) on Monday. Copying this formula to R4:R9 calculates the 

number of promotions on each day of the week.

Calculating the Average Cookie Sales on Each Day of the Week
The formula in U3 =AVERAGEIF(daywk,T3,Cookies) averages the number of cookie 

sales on Monday. Copying this formula to the range U4:U9 calculates average cookie 

sales for all other days of the week.

Computing Monthly Sales for each Product
The formula =SUMIFS(INDIRECT(R$13),Namemonth,$Q14) in cell R14 computes total 

cake sales in January (7726). 

 1. Place the INDIRECT function before the reference to R13 to enable Excel to 

recognize the word “Cakes” as a range name. 

 2. Copy this formula to the range R14:V25. This calculates the total sales for 

each product during each month. 

NOTE Note the INDIRECT function makes it easy to copy formulas involving 

range names. If you do not use the INDIRECT function then Excel will not recognize 

text in a cell such as R13 as a range name.

Computing Average Daily Sales by Month for Each Product
The formula =AVERAGEIFS(INDIRECT(R$28),Namemonth,$Q29) in cell R29 com-

putes average cake sales in January. Copying this formula to the range R29:V40 

calculates average sales during each month for each product. Figure 3-8 

shows this example. 

Summarizing Data with Subtotals
The fi nal method to summarize market data discussed in this chapter is with sub-

totals. The subtotals feature yields a great looking summary of data. Unfortunately, 

if new data is added, subtotals are diffi  cult to update. Suppose you want to get a 

breakdown for each day of the week and for each product showing how sales diff er 

on days with and without promotions (see the Subtotals Bakery worksheet). Before 

computing subtotals you need to sort your data in the order in which you want your 

subtotals to be computed. In the subtotals you want to see the day of the week, and 
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then “promotion” or “not promotion.” Therefore, begin by sorting the data in this 

order. The dialog box to create this sort is shown in Figure 3-9.

Figure 3-8: Using AVERAGEIFS to summarize monthly sales

Figure 3-9: Sorting in preparation for subtotals

After performing the sort you see all the Sundays with no promotion, 

followed by the Sundays with a promotion, then the Mondays with no promotion 

days, and so on. Perform the following steps to continue: 

 1. Place your cursor anywhere in the data and select Subtotal from the Data tab 

on the ribbon. 

 2. Compute Subtotals for each product for each day of the week by fi lling in the 

Subtotals dialog box, as shown in Figure 3-10. 
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Figure 3-10: Subtotals settings for daily summary

 3. Next you “nest” these subtotals with totals each day of the week for no pro-

motion and promotion days. To compute the nested subtotals giving the 

breakdown of average product sales for each day of the week on promotion 

and no promotion days, select Subtotal from the Data tab and fi ll in the dialog 

box, as shown in Figure 3-11.

 4. Select OK and the Subtotals feature creates for each day of the week total 

sales for each product. This summary (as shown in Figure 3-12) can be seen 

by clicking the number 2 in the upper left corner of your screen.  

Figure 3-11: Final subtotals dialog box

By unchecking Replace Current Subtotals, you ensure that the subtotals on 

Promotions will build on and not replace the daily calculations. By clicking the 3 

in the upper-left corner of the screen, you can fi nd the fi nal breakdown (see Figure 
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Using Array Formulas to Summarize ESPN The 
Magazine Subscriber Demographics
The six wonderful functions previously discussed are great ways to calcu-

late conditional counts, sums, and averages. Sometimes, however, you might 

want to compute a conditional median, standard deviation, percentile, or some 

other statistical function. Writing your own array formulas you can easily cre-

ate your own version of a MEDIANIF, STDEVIF, or other conditional statistical 

functions.

NOTE The rules for array formulas discussed in “Summarizing Data with a 

Histogram” also apply to array formulas that you might write.

To illustrate the idea, look at the Chapter 1 data on ESPN subscribers located in 

the Slicing with arrays worksheet (see also Figure 3-14). 

Figure 3-14: Using arrays to compute conditional medians and standard deviations
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 9. Exercises 9-12 use the data in the Descriptive stats worksheet of the 

Chapter3bakery.xlsx workbook. Determine the percentage of La Petit Bakery 

cookie sales for each day of the week and month combination. For example, 

your fi nal result should tell you the fraction of cookie sales that occur on a 

Monday in January, and so on.

 10. Determine the average profi t earned for each day of the week and month 

combination. Assume the profi t earned by La Petit Bakery on each product 

is as follows:

 ■ Cakes: $2

 ■ Cookie: $0.50

 ■ Pie: $1.50

 ■ Smoothie: $1.00

 ■ Coffee: $0.80

 11. Find the median cake sales on days in which at least 500 cookies were sold.

 12. Fill in the blank: On days in which at least 500 cookies are sold there is a 5 

percent chance at least _____ cookies are sold.

 13. In the years 1980–2012 median U.S. family income (after inflation) has 

dropped but mean family income has sharply increased. Can you explain 

this seeming anomaly?

 14. Compute and interpret the skewness for the three data sets in the file 

Skewexamples.xlsx.
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quantity of the product demanded for each price, you can use the Microsoft Offi  ce 

Excel Solver feature to fi nd the profi t-maximizing price.

Price Elasticity
Given a demand curve, the price elasticity for demand is the percentage of decrease 

in demand resulting from a 1 percent increase in price. When elasticity is larger 

than 1, demand is price elastic. When demand is price elastic, a price cut will 

increase revenue. When elasticity is less than 1, demand is price inelastic. When 

demand is price inelastic, a price cut will decrease revenue. Studies by economists 

have obtained the following estimates of elasticity:

 ■ Salt: 0.1 (very inelastic)

 ■ Coff ee: 0.25 (inelastic)

 ■ Legal fees: 0.4 (inelastic)

 ■ TV sets: 1.2 (slightly elastic)

 ■ Restaurant meals: 2.3 (elastic)

 ■ Foreign travel: 4.0 (very elastic)

A 1 percent decrease in the cost of foreign travel, for example, can result in a 4 

percent increase in demand for foreign travel. Managers need to understand the 

price elasticity at each price point to make optimal pricing decisions. In the next 

section you will use price elasticity to estimate a product’s demand curve.

Forms of Demand Curves
There are multiple forms of demand curves that you can use to analyze marketing 

data. Using q to represent the quantity demanded of a product, the two most com-

monly used forms for estimating demand curves are as follows:

 ■ Linear demand curve: In this case, demand follows a straight line rela-

tionship of the form q = a – bp. Here q = quantity demanded and p = unit 

price. For example, q = 10 – p is a linear demand curve. (Here a and b can 

be determined by using a method described in the “Estimating a Linear 

Demand Curve” section of this chapter.) When the demand curve is linear, 

the elasticity is changing. 

 ■ Power demand curve: In this situation, the demand curve is described by a 

power curve of the form q = apb, a>0, b<0. Again, a and b can be determined 

by the method described later in the chapter. The equation q = 100p-2 is an 

example of a power demand curve. If demand follows a power curve, for 

any price, the elasticity equals –b. See Exercise 11 for an explanation of this 
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important property of the power demand curve. Thus, for the demand curve 

q = 100p-2 the price elasticity of demand always equals 2. 

Estimating a Linear Demand Curve
Suppose that a product’s demand curve follows a linear demand curve. Given the 

current price and demand for a product and the product’s price elasticity of demand, 

determining the product’s demand curve is a simple matter. The following example 

illustrates how to fi t a linear demand curve.

Suppose a product is currently selling for $100 and demand equals 500 units. The 

product’s price elasticity for demand is 2. Assuming the demand curve is linear, you 

can determine the equation of the demand curve. The solution is in the Linearfit

.xls fi le, which is shown in Figure 4-1.

Figure 4-1: Fitting linear demand curve

Given two points, you know that there is a unique straight line that passes 

through those two points. You actually know two points on your demand curve. 

One point is p=100 and q=500. Because elasticity of demand equals 2, a 1 percent 

increase in price results in a 2 percent decrease in demand. Thus, if p=101 (a 1 per-

cent increase), demand drops by 2 percent of 500 (10 units) to 490. Thus p=101 and 

q=490 is a second point on the demand curve. You can now use the Excel Trendline 

to fi nd the straight line that passes through the points (100,500) and (101,490).

Begin by entering these points in the worksheet in the cell range D5:E6 (refer to 

Figure 4-1). Then select the range D4:E6, and on the Ribbon, in the Charts group 

choose Scatter ➢ Scatter with Only Markers. 

 1. Begin by entering the points in the Linearfit.xls worksheet in the cell range 

D5:E6 (refer to Figure 4-1).

 2. Select the range D4:E6.
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 3. Go to the Insert tab and in the Charts group choose Scatter ➢ Scatter with 

Only Markers. You should now see that the graph has a positive slope.

This would imply that higher prices lead to higher demand, which cannot be 

correct. The problem is that with only two data points, Excel assumes that 

the data points you want to graph are in separate columns, not separate rows.

 4. To ensure Excel understands that the individual points are in separate rows, 

click inside the graph.

 5. On the Ribbon click the Design tab in the Chart Tools section.

 6. Click Switch Row/Column in the Data section of the Design tab.

NOTE Note that by clicking the Select Data button, you can change the source 

data that generates your chart.

 7. Next, right-click one of the points and then click Add Trendline.

 8. Click the Linear button and click Display Equation on Chart option.

 9. Click Close in the Format Trendline box. 

You see the straight line plot, complete with the equation referred to in Figure 

4-1. Because x is price and y is demand, the equation for your demand curve is 

q = 1500 – 10p. This equation means that each $1 increase in price costs 10 units 

of demand. Of course, demand cannot be linear for all values of p because for large 

values of p, a linear demand curve yields negative demand. For prices near the cur-

rent price, however, the linear demand curve is usually a good approximation to 

the product’s true demand curve.

Estimating a Power Demand Curve
Recall that for a linear demand curve the price elasticity is diff erent for each price 

point. If the marketing analyst believes that elasticity remains relatively constant as 

price changes, then she can use a power demand curve (which has constant price 

elasticity) to model demand for a product.

Again assume that a product is currently selling for $100 and demand equals 

500 units. Assume also that the product’s price elasticity for demand is known to 

equal 2. (In Chapters 31 and 32 you will learn some more advanced methods to 

estimate price elasticity). You can fi t a power demand curve to this information by 

performing the following steps in the Powerfit.xls fi le, as shown in Figure 4-2.
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Figure 4-2: Fitting Power Demand Curve

 1. After naming cell E3 as a, enter a trial value for a.

 2. In cell D5, enter the current price of $100. Because elasticity of demand equals 

2, you know that the demand curve has the form q=ap-2 where a is unknown.

 3. In cell E5, enter a formula that computes the demand when the unit price 

equals $100. The demand is linked to your choice of the value of a in cell E3 

with the formula a*D5^−2.

 4. Now use the Global Seek  command to determine the value of a. 

This formula makes the demand for price $100 equal to 500 units. 

Goal Seek enables you to fi nd a value of a cell in a spreadsheet (called the 

By Changing Cell) that makes a formula (called the Set Cell) hit a wanted 

Value. In the example you want to change cell E3 so that the formula in cell 

E5 equals 500. Set cell E5 to the value of 500 by changing cell E3.

 5. To invoke Goal Seek, switch to the Data tab and select What-If analysis from 

the Data Tools Group, then choose Goal Seek from the drop down arrow. Fill 

the dialog box as shown in Figure 4-3. With these settings, Excel changes the 

changing cell (E3) until the value of the set cell (E5) matches your desired 

value of 500.

A value for a = 5 million yields a demand of 500 at a price of $100. Thus, the 

demand curve (refer to Figure 4-2) is given by q = 5,000,000p-2. For any price, the 

price elasticity of demand on this demand curve equals 2.
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 ■ Changing Variable Cells: These cells are the cells that you can change or 

adjust to optimize the target cell. In this chapter the changing cells will be 

each product’s price.

 ■ Constraints: These are restrictions on the changing cells. For example, you 

might want to constrain the price for each of your products to be within 10 

percent of the competitor’s price.

Figure 4-4: Solver window

The Excel Solver has been greatly revamped and improved in Excel 2010. The 

primary change is the presence of the Select a Solving Method drop-down list. 

From this list you must select the appropriate solution engine for your optimization 

problem. You can choose from the following options:

 ■ The Simplex LP engine is used to solve linear optimization problems. A linear 

optimization problem is one in which the target cell and constraints are all 

created by adding together terms of the form (changing cell)*(constant). Most 
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marketing models are not linear. An exception is the classic advertising media 

selection model discussed in Chapter 35, “Media Selection Models.”

 ■ The GRG Nonlinear engine is used to solve optimization problems in which 

the target cell and/or some of the constraints are not linear and are computed 

by using typical mathematical operations such as multiplying or dividing 

changing cells, raising changing cells to a power, using exponential or trig 

functions involving changing cells, and so on. The GRG engine includes a 

powerful Multistart option that enables users to solve many problems that 

were solved incorrectly with previous versions of Excel. The Multistart option 

will be used extensively throughout this book.

 ■ The Evolutionary engine is used when your target cell and/or constraints 

contain nonsmooth functions that reference changing cells. For example, 

if your target cell and/or constraints contain IF, SUMIF, COUNTIF, SUMIFS, 

COUNTIFS, AVERAGEIF, AVERAGEIFS, ABS, MAX, or MIN functions that reference 

the changing cells, then the Evolutionary engine probably has the 

best shot at finding a good solution to your optimization problem. 

The Evolutionary engine is extensively used throughout this book.

After you have input the target cell, changing cells, and constraints, what does 

Solver do? A set of values for the changing cells is a feasible solution if it meets all 

constraints, and the Solver essentially searches through all feasible solutions and 

fi nds the set of feasible solution changing cell values (called the optimal solution) 

that has the best value for the target cell (largest in a maximization and smallest 

in a minimization). If there is more than one optimal solution, the Solver stops at 

the fi rst one it fi nds.

Pricing Razors (No Blades!)
Using the techniques described in the “Estimating a Linear Demand Curve” section, 

it’s easy to determine a demand curve for the product that’s originally purchased. 

You can then use the Microsoft Offi  ce Excel Solver to determine the original product 

price that maximizes the sum of the profi t earned from razors. Then you can show 

how the fact that purchasers of razors also buy blades reduces the profi t maximizing 

price for razors.

Suppose that you currently charge $5.00 for a razor and you sell 6 million razors. 

Assume that the variable cost to produce a razor is $2.00. Finally, suppose that the 
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price elasticity of demand for razors is 2, and the demand curve is linear. What 

price should you charge for razors?

You can determine a demand curve (assuming a linear demand curve), as 

shown in Figure 4-5. (You can fi nd this data and the chart on the no blades 

worksheet in the fi le razorsandblades.xls.) Two points on the demand curve 

are price = $5.00, demand = 6 million razors and price = $5.05 (an increase of 1 

percent), demand = 5.88 million (2 percent less than 6 million).

 1. Begin by drawing a chart and inserting a linear trend line, as shown 

in the section “Estimating a Linear Demand Curve.” You’ll find 

the demand curve equation is y = 18 –2.4x. Because x equals price 

and y equals demand, you can write the demand curve for razors as follows: 

Demand (in millions) = 18 – 2.4(price)

Figure 4-5: Optimizing razor price: no blades

 2. Associate the names in cell C6 and the range C9:C11 with cells D6 and 

D9:D11. 

 3. Next, enter a trial price in D9 to determine demand for that price in cell D10 

with the formula =18−2.4*price. 

 4. Determine in cell D11 the profit for razors by using the formula 

=demand*(price–unit_cost).

 5. You can now use Solver to determine the profi t-maximizing price. The Solver 

Parameters dialog box is shown in Figure 4-6. Choose to maximize the profi t 

cell (cell D11) by changing the price (cell D9). 

 6. The model is not linear because the target cell multiplies together two quanti-

ties—demand and (price–cost)—each depending on the changing cell. Therefore 

choose the GRG Nonlinear option. Solver fi nds that by charging $4.75 for a 

razor, you can maximize the profi t. (The maximum profi t is $18.15 million.)
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Figure 4-6: Solver window for razor price: no blades

Incorporating Complementary Products 
Certain consumer product purchases frequently result in the purchase of related 

products, or complementary products. Table 4-1 provides some examples:

Table 4-1: Examples of Complementary Product 

Original Purchase Tie-in Complementary Product

Men’s suit Tie or shirt

Inkjet printer Printer cartridge

Xbox console Video game

Cell phone Case

If the profi t from complementary products is included in the target cell, the 

profi t maximizing price for the original product will decrease. Suppose that the 

average purchaser of a razor buys 50 blades and you earn $0.15 of profi t per blade 
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purchased. You can use the Excel Solver to determine how this changes the price 

you should charge for a razor. Assume that the price of a blade is fi xed. (In Exercise 

3 at the end of the chapter, the blade price changes.) The analysis is in the blades 

worksheet of the razorsandblades.xls fi le, as shown in Figure 4-7. 

Figure 4-7: Optimizing razor price: blade profi t included

To maximize profi t perform the following steps: 

 1. Use the Create from Selection command in the Defi ned Names group on the 

Formulas tab to associate the names in cells C6:C11 with cells D6:D11. (For 

example, cell D10 is named Demand.)

NOTE Recall that cell D10 of the no blades worksheet is also named Demand. 

When you use the range name Demand in a formula Excel simply refers to the 

cell named Demand in the current worksheet. In other words, when you use the 

range name Demand in the blades worksheet, Excel refers to cell D10 of that 

worksheet, and not to cell D10 in the no blades worksheet.

 2. In cells D7 and D8, enter the relevant information about blades. 

 3. In D9, enter a trial price for razors, and in D10, compute the demand with 

the formula 18-2.4*price. 

 4. Next, in cell D11, compute the total profi t from razors and blades with the 

following formula: 

demand*(price–unit_cost)+demand*blades_per_razor*profit_per_blade

Here the demand*blades_per_razor*profit_per_blade is the profit from 

blades.

 5. The Solver setup is exactly as shown earlier in Figure 4-6: Change the price 

to maximize the profi t. Of course, now the profi t formula includes the profi t 

earned from blades. 
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 3. Right-click a data point and select Add Trendline. 

 4. In the Format Trendline dialog box, choose Polynomial, and select 2 in the 

Order box to obtain a quadratic curve of the form of Equation 1. Then select 

the option Display Equation on Chart. Figure 4-8 shows the required Trend 

Curve Settings. The chart containing the demand curve is shown in Figure 4-9.

The estimated demand curve Equation 2 is as follows: 

(2) Demand = –44 * Price2 + 136 * Price – 45

 5. Next, insert a trial price in cell I2. Compute the product demand by using 

Equation 2 in cell I3 with the formula =–44*price^2+136*price–45. (Cell I2 

is named Price.) 

Figure 4-8: Pricing with a quadratic demand curve

 6. Compute the weekly profi t from ChapStick sales in cell I4 with the formula 

=demand*(price–unit_cost). (Cell E2 is named Unit_Cost and cell I3 is 

named Demand.) 

 7. Use Solver to determine the price that maximizes profi t. The Solver Parameters 

dialog box is shown in Figure 4-10. The price is constrained to be from the 

lowest through the highest specifi ed prices ($1.50 through $2.50). If you 

allow Solver to consider prices outside this range, the quadratic demand curve 
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might slope upward, which implies that a higher price would result in larger 

demand. This result is unreasonable, which is why you constrain the price.

Figure 4-9: ChapStick demand curve

Figure 4-10: Solver window for quadratic demand curve example
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 6. Copy the formula =(E14-F14)^2 from G14 to G15:G16 to compute the squared 

error in the demand forecast for each price. For each price the estimation error 

is simply actual demand minus demand estimated from quadratic demand 

curve.

 7. In cell G12 use the formula =SUM(G14:G16) to compute the sum of the squared 

estimation errors.

 8. If you minimize G12 by changing E3:E5, Solver fi nds the values of a, b, and 

c that make the sum of squared errors equal to 0. You minimize the sum of 

squared errors instead of minimizing the sum of errors because if you do not 

square errors, then the sum of positive and sum of negative errors cancels 

each other out. Minimizing the sum of squared errors mimics the action of 

the Trend Curve Polynomial option described in the preceding section. The 

appropriate Solver Window is shown in Figure 4-11.

Figure 4-11: Solver window for SolverTable example



Estimating Demand Curves and Using Solver to Optimize Price 101

   

 9. Choose the GRG Nonlinear option because the target cell is not constructed 

by adding up terms of the form (changing cell)*constant. 

 10. For Solver to obtain a correct solution to this problem, go to Options and 

check Use Automatic Scaling; then go to the GRG tab and select Central 

Derivatives.

 11. Select Solve and you find the answer (see Figure 4-12). The Sum of 

Squared errors is 0 to 26 decimal places and the quadratic demand curve is 

−73.625+195price+87.5price^2. Because a, b, and c can be negative, do not 

check the Make Unconstrained Variables Non-Negative box.

Figure 4-12: Use of SolverTable for price optimization

Using SolverTable to Find the Demand Curve for All 
Products
After you have a Solver model in a worksheet, you can use SolverTable to “loop 

through” the values of one (in a One-way SolverTable) or two (in a Two-way 

SolverTable) inputs and track any wanted outputs. To get started, assuming you 

have installed SolverTable, select SolverTable from the Ribbon, choose a One-way 

Table, and fi ll in the SolverTable dialog box, as shown in Figure 4-13.

To begin Solver place a 1 in the input cell (A11) and run the Solver to track the 

output cells (a, b, and c and Sum of Squared Errors [SSE]). Then Solver places a 2 

in A11 and fi nally a 3 in A11. The results are placed in a new worksheet (STS_1), as 

shown in Figure 4-14.



Part II: Pricing102

   

Figure 4-13: SolverTable settings

Figure 4-14: SolverTable results

You can now set up a Solver model that determines the profi t maximizing price 

for each product. Proceed as follows:

 1. Enter trial prices for each product in the range F5:F7.

 2. Based on the prices in F5:F7, compute the demand for each product by copy-

ing the formula =B5+C5*F5+F5^2*D5 from G5 to G6:G7.

 3. Enter the unit cost for each product in H5:H7, and compute the profi t for 

each product as (price-unit cost)*demand by copying the formula =(F5-H5)*G5 

from I5 to I6:I7.

 4. Compute the total profit for all products in cell I2 with the formula 

=SUM(I5:I7).







Estimating Demand Curves and Using Solver to Optimize Price 105

   

Figure 4-16: Data for Exercise 5

 6. A prescription drug is produced in the United States and sold internationally. 

Each unit of the drug costs $60 to produce. In the German market, you sell 

the drug for 150 euros per unit. The current exchange rate is 0.667 U.S. dol-

lars per euro. Current demand for the drug is 100 units, and the estimated 

elasticity is 2.5. Assuming a linear demand curve, determine the appropriate 

sales price (in euros) for the drug.

 7. Suppose it costs $250 to produce a video game console. A price between $200 

and $400 is under consideration. Estimated demand for the game console is 

shown in the following table. What price should you charge for game console?

Price Demand

$200 50,000

$300 25,000

$400 12,000

 8. Use the demand information given in Exercise 7 for this exercise. Each game 

owner buys an average of 10 video games. You earn $10 profi t per video game. 

What price should you charge for the game console?

 9. You want to determine the correct price for a new weekly magazine. The 

variable cost of printing and distributing a copy of the magazine is $0.50. You 

are thinking of charging from $0.50 through $1.30 per copy. The estimated 

weekly sales of the magazine are shown in the following table. What price 

should you charge for the magazine?

Price Demand (in Millions)

$0.50 2

$0.90 1.2

$1.30 .3
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 10. Given the following information in the table for four products, fi nd the profi t-

maximizing price for each product.

 Product
Lowest 
Price

Medium 
Price

High 
Price

Low 
Price 
Demand

Medium 
Price 
Demand

High 
Price 
Demand

Unit 
cost

Product 1 $1.40 $2.20 $3.00 100 40 5 $1.10

Product 2 $2.20 $3.00 $4.00 200 130 25 $1.50

Product 3 $45 $75 $95 400 300 130 $40

Product 4 $200 $250 $300 600 300 50 $120

 11. (Requires calculus) Show that if the demand for a product is given by the 

power curve q = ap-b, then for any price a, a 1 percent increase in price will 

decrease demand by 1 percent.

 12. For the demand curve q =100p-2 show that for p = 1, 2, 4, 8, and 16 that a 1 

percent increase in price will result in approximately a 2 percent decrease in 

demand.
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Pure Bundling 
Now consider another example. Suppose you sell two products and have two poten-

tial customers that value each product, as shown in Table 5-1:

Table 5-1: Pure Bundling Works Well with Negatively Correlated Valuations

Product Customer 1 Customer 2

Computer $1,000 $500

Monitor $500 $1,000

For simplicity, assume the cost of producing each product is negligible and can 

be assumed to equal $0. Therefore revenue and profi t are identical. In this example 

customer valuations are negatively correlated; Customer 1 values the computer more 

than Customer 2 but values the monitor less. If you price each product separately, 

you would charge $1,000 for each product and make $2,000 revenue; however, if 

you charge $1,500 for a bundle of both products, you make $3,000. Thus, when 

customer valuations for products are negatively correlated, bundling can result in a 

signifi cant increase in profi t. 

The reason bundling works in this case is that bundling enables the seller to 

entirely extract the value the consumers attach to the products. If the seller only 

off ers the customer a choice between purchasing all products or nothing, the situ-

ation is called pure bundling. Movie rental companies usually give theatres a choice 

between renting an assortment of some blockbuster movies and some not-so-popular 

movies, or renting no movies at all. In this case if the theatre owner wants the 

blockbuster movies she has to also rent the less-popular movies.

If customer valuations are positively correlated then bundling usually off ers no 

benefi t, because bundling does not allow the seller to extract more surplus than sep-

arate prices. For example, in Table 5-2 valuations are positively correlated because 

Customer 2 is willing to pay more for each product than Customer 1. In this case, if 

the seller off ers only separate prices she would charge $1,000 for the computer and 

$500 for the monitor. Then each customer buys both products and total revenue is 

$3,000. If the seller off ers a pure bundle she should charge $1,500 for the bundle. 

Then both customers purchase the bundle for $1,500 yielding a total revenue of 

$3,000. In this this case pure bundling and separate prices yield identical profi ts.
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Table 5-2: Pure Bundling Works Poorly with Positively Correlated Valuations

Product Customer 1 Customer 2

Computer $1,000 $1,250

Monitor $500 $750

Mixed Bundling
Mixed bundling means the seller off ers a diff erent price for each available combi-

nation of products. For the data in Table 5-3 mixed bundling is optimal.

Table 5-3: Mixed Bundling is Optimal

Customer Computer Monitor

1 $900 $800

2 $1,100 $600

3 $1,300 $400

4 $1,500 $200

Unit Cost $1,000 $300

To maximize profi ts, the seller can do the following (see also Exercise 7):

 ■ To maximize profi t from separate prices the seller charges $600 for the moni-

tor and $1,300 for the computer. In this scenario Customers 3 and 4 buy the 

computer and Customers 1 and 2 buy the monitor yielding a profi t of $1,200.

 ■ To maximize profi t with mixed bundling the seller can charge $799 for the 

monitor, $1,499 for the computer, and $1,700 for the bundle. Then Customer 

1 buys just a monitor, Customer 4 buys just a computer, and Customers 2 

and 3 buy the product bundle. The seller earns a profi t of $1,798.

 ■ If only the monitor and computer pure bundle is off ered, the seller should 

sell the pure bundle for $1,700. Then each customer will purchase the pure 

bundle and the seller earns a profi t of $1,600.
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The key to your model is to set up a spreadsheet that tells you, for any set of 

prices for each possible product combination, how much revenue you can obtain 

from your sample of customers. Then you can use the Evolutionary Solver to fi nd 

the set of prices for the product combinations that maximize your revenue. To fi nd 

how much revenue you can generate for any set of product combination prices, 

proceed as follows:

 1. In D4:J4 enter trial prices for each of the possible seven product combinations.

 2. In Row 6, determine the fi rst’s customer’s consumer surplus by computing 

her value for the products in a combination and subtracting the cost of the 

product combination. For example, the fi rst customer’s consumer surplus 

for the Internet +TV product combination is computed in cell G6 with the 

formula =A6+B6-G$4. Copy the formulas in row 6 to the cell range D7:J82 to 

compute each customer’s consumer surplus for each product combination.

 3. Determine for the set of prices in row 4 which product combination, if any, 

is purchased. Copy the formula =MAX(D6:J6) from K6 to K7:K82 to fi nd each 

consumer’s surplus.

 4. Now here’s the key to your spreadsheet. In Column L you use the MATCH func-

tion (introduced in Chapter 2, “Using Excel Charts to Summarize Marketing 

Data”) combined with an IF statement to determine which product combina-

tion each customer purchases. Use product combination 0 to denote no pur-

chase, whereas the actual product combinations are indicated by the integers 

1–7. Copy the formula =IF(K6<0,0,MATCH(K6,D6:J6,0)) from L6 to L7:L82 

yields the product combination (if any) bought by each customer.

 5. Copy the formula =IF(L6=0,0,HLOOKUP(L6,$D$3:$J$4,2)) from M6 to 

M7:M82 to compute for each person the revenue generated.

 6. In cell M4, compute your total revenue with the formula =SUM(M6:M82).

To fi nd the product combination prices that maximize revenue you need to use 

the Evolutionary Solver, so some discussion of the Evolutionary Solver is in order.

Introduction to the Evolutionary Solver
As explained in Chapter 4, “Estimating Demand Curves and Using Solver to 

Optimize Price,” the Evolutionary Engine is used when your target cell and con-

straints contain nonsmooth functions that reference changing cells. For example, 

if your target cell and constraints contain IF, SUMIF, COUNTIF, SUMIFS, COUNTIFS, 

AVERAGEIF, AVERAGEIFS, ABS, MAX, or MIN functions that reference the changing cells, 
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then the Evolutionary engine probably has the best chance to fi nd a good solution 

to your optimization problem. The model makes extensive use of IF statements, 

so it is a good choice to use the Evolutionary Solver. The target cell is to maximize 

revenue (cell M3) by changing the product prices (cell range D4:J4).

When using the Evolutionary Solver, you should follow these rules:

 ■ Place upper and lower bounds on each of your changing cells. This makes the 

Solver’s search for an optimal solution much easier. In the Verizon bundling 

model use a lower bound of 0 for each price and an upper bound of 100. 

NOTE If, when running Evolutionary Solver, a changing cell hits an upper or 

lower bound, you should relax that bound because Solver was trying to push the 

changing cell outside the range you specifi ed.

 ■ Use no constraints other than the bounds on the changing cells. You will 

soon see how to use penalties in the target cell to enforce constraints.

 ■ In the Options tab increase Max Time to 3600 seconds. This causes Solver to 

run for 60 minutes, even if you leave the room. This should be plenty of time 

for Solver to fi nd a good solution. Also add a few 000s to Max Subproblems 

and Max Feasible Solutions. This ensures that Solver does not stop when you 

leave the room. Figure 5-2 summarizes these settings.

 ■ In the Options tab select the Evolutionary Solver tab and change Mutation Rate 

to 0.5 and Maximum Time Without Improvement to 300 seconds. (Mutation 

rate is explained soon.) Setting a Maximum Time Without Improvement to 5 

minutes ensures that if Solver fails in 5 minutes to improve the current solu-

tion, the Solver stops. Hitting the Escape key at any time stops the Solver.

Evolutionary algorithms (often called genetic algorithms) were discovered by John 

Holland, a Michigan computer science processor. Evolutionary Solver begins with 

between 50 and 200 “solutions,” which are randomly chosen values of the changing 

cells that lie between the lower and upper bounds for each changing cell. The exact 

number of solutions used is specifi ed in the Population Size fi eld in Figure 5-3. The 

default value is 100, which is fi ne. Then the target cell value is computed for each 

solution. By a process of “reproduction” explained in David Goldberg’s textbook 

Genetic Algorithms (Addison-Wesley, 1989), a new set of 100 solutions is obtained. 

Previous solutions that have “good” values (large in a Max problem and small in a 

Min problem) have a better chance of surviving to the next generation of solutions. 

This is the mathematical implementation of Darwin’s survival of the fi ttest principle.
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Figure 5-2: Evolutionary Solver settings

The Excel Solver also enables solutions to improve via Mutation. To understand 

how Mutation works you need to know that Excel codes each value of a changing 

cell in binary notation. For example, the number 9 is coded as 1001 (1 * 23 + 0 * 

22 + 0 * 21 + 1). 

A Mutation in the Evolutionary Solver changes a 0 to a 1 or a 1 to a 0. A higher 

value for the Mutation rate moves you around more in the feasible region but 

exposes you to a larger probability of being led on a wild goose chase after moving 

to a part of the feasible region with poor changing cell values. A Mutation rate 

of .5 usually yields the best results. Figure 5-3 shows the Mutation rate changed 

to .5. The amazingly simple Evolutionary Solver search procedure based on sur-

vival of the fi ttest can solve extraordinarily complex problems! When solving a 

problem the Evolutionary Solver must make many random choices. This means 

that if two diff erent people run the same model, then after 5 minutes or so they 

may see diff erent optimal solutions. Eventually they should see target cell values 

that are virtually identical.



Price Bundling 115

   

Figure 5-3: Changing the Mutation rate

Finding the Optimal Bundle Prices
The Solver window shown in Figure 5-4 enables you to fi nd revenue maximizing 

the set of prices for each product combination. A maximum profi t of $3,413.70 

(see worksheet initial solver) is found with the product combination prices, as 

shown in Figure 5-5.

NOTE Unlike the GRG or Simplex Solver engine, the Evolutionary Solver engine 

is only guaranteed to fi nd a near optimal solution (as opposed to an optimal solu-

tion). Therefore, when you run the Evolutionary Solver on the book’s examples, 

do not be surprised if your optimal target cell value diff ers slightly from the target 

cell value shown in the book.
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Figure 5-4: Initial bundling Solver model

Figure 5-5: Solution to initial bundling model

Unfortunately, you could not go to market charging $74.35 for Internet service and 

$69.99 for Internet + TV service because it is unreasonable to provide two services 

for a lower price than a single service. This situation is called a price reversal. As 

you soon see, the reason Solver charged a higher price for Internet service than for 

Internet and TV service is because the revenue maximizing prices involve nobody 

just buying Internet service, so a high price helps ensure that nobody buys just 

Internet service.

Take a look at the final solver worksheet, and you see it contains the same 

prices found in the initial solver worksheet. The cell range P70:Q81 in the final 
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solver worksheet (as shown in Figure 5-6) computes the price reversals for each 

possible combination of a product with a larger combination of products. In column 

P, the price of the smaller product combination is subtracted from the price of the 

larger product combination. For example, in P71 the formula =D4-G4 computes the 

Internet Price – (Internet + TV Price). The diff erence of $4.36 indicates that the 

Internet + TV price is $4.36 lower than the Internet price. To ensure that no price 

reversals occur, the target cell is penalized $500 for each dollar of price reversal. 

Then, survival of the fi ttest should ensure that no price reversals survive. The choice 

of penalty amount is an art, not a science. Too large a penalty (such as $1 million) 

seems to work poorly, and too small a penalty does not “kill off ” the things you 

want to avoid. 

Figure 5-6: Price reversals for initial Solver solution

You can copy the formula =IF(P70>0,P70,0) from Q70 to Q71:Q82, to track the 

price reversal because it yields a value of 0 if the product comparison does not have 

a price reversal. With the formula =SUM(M6:M82)-500*Q82 you can incorporate your 

penalty in the target cell. The Solver window is the same (refer to Figure 5-4). After 

running the Solver you can fi nd the optimal solution, as shown in Figure 5-7.

Therefore, after completing all the calculations, a maximum profi t of $3,413.90 

is obtained by charging the following:

 ■ $47.41 for Internet service

 ■ $35 for TV service

 ■ $67.87 for cell phone service

 ■ $70 for any two product combination

 ■ $89.95 for all three products
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Figure 5-7: Final bundling solution

The consumer is given a substantial discount if she buys two or more products. 

You can copy the formula =COUNTIF($L$6:$L$82,N9) from O9 to O10:O16 to fi nd 

the number of people purchasing each product combination. As shown in Figure 

5-8, 25 people buy nothing; nobody buys just the Internet; 19 buy just TV; nobody 

buys just the cell phone; 8 buy the Internet + TV; 2 buy Internet + cell phone; 1 

buys TV + cell phone; and 22 people buy the bundle! Your pricing helped extract 

the high value people place on the Internet and cell phone service by incentivizing 

these people to buy more than one service. Note the high prices for the Internet and 

cell phone are designed to give customers an incentive to purchase more products.

Figure 5-8: Number of purchases of each product combination

This method will automatically determine whether separate prices, mixed bun-

dling, or pure bundling is optimal.
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 a. If you charge a single price for all songs, how can you maximize 

revenue?

 b. If you can charge two diff erent prices for songs, how can you maximize 

revenue?

Figure 5-10 Data for Exercise 2

 3. Kroger is trying to determine which types of Vanilla Wafer cookies to stock. 

The wholesale cost Kroger is charged for a box of each type of cookie is shown 

in the following table:

National 1 National 2 Generic Copycat 

$1.5 $2.00 $0.90 $1.25

The wholesale price of a box of cookies is assumed equal to the product’s 

quality. Each customer assigns a different value to quality, as shown in file 

Wafersdata.xlsx and Figure 5-11. For example, Customer 7 would value 

National 1 at 1.02 * (1.5), and so on. Your task is to determine how to price 

each type of cookie and then to recommend which brands Kroger should 

stock to maximize profit from cookies.
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Figure 5-11 Valuations for Exercise 3

 4. Microsoft is going to sell a Student version of Offi  ce (excluding Access and 

Outlook) and a full version of Offi  ce. Assume there are three market segments 

whose size and valuations for each version of Offi  ce are given in the following 

table. What price for each version of Offi  ce can maximize Microsoft’s revenue?

Segment Student Version Full Version Size

Students 110 160 20%

Individuals (nonstudent) 170 300 40%

Businesses 240 500 40%

 5. The New York Times wants to price home subscriptions and web access. Of 

course, people can buy both home subscriptions and web access. Assume there 

are three market segments whose size and valuations (per month) for each 

product combination are given here. The cost to provide a home subscription 

is $15 and the variable cost to provide web access is $1.

Segment
Home 
Subscription Web Access

Home 
+Web Size

1 $30 $35 $50 25%

2 $35 $15 $40 40%

3 $20 $20 $25 35%

What prices maximize monthly profits?
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 6. Before publishing a hardcover book, a publisher wants to determine the proper 

price to charge for the hardcover and paperback versions. The fi le paperback

.xlsx contains the valuations of 50 representative potential purchasers of 

the book. Suppose the unit cost of the hardcover book is $4 and the unit 

cost of the paperback is $2. If the bookstore charges double what it pays the 

publisher, what price should the publisher charge the bookstore for each 

version of the book?

 7. For the data in Table 5-3 verify that the given mixed bundling strategy maxi-

mizes the seller’s profi t.

 8. Describe a situation in which a bank can benefi t from a bundling strategy.

 9. Suppose your company sells four products and during a year a customer will 

buy each product at most once. Your company would like to give an end-

of-year rebate of 10 percent off  to customers who purchase at least $1,000 

of products. How can the methods of this chapter be used to maximize your 

company’s profi ts?



   

6
Nonlinear pricing is used in a situation in which the cost of purchasing q units is 

not equal to the unit cost c per unit times q. Bundling (discussed in Chapter 5, 

“Price Bundling”) is a special type of nonlinear pricing because the price of three items 

is not equal to the sum of the individual prices. 

Other common examples of nonlinear pricing strategies include: 

 ■ Quantity discounts: If customers buy ≤CUT units, they pay high price (HP) 

per unit, and if they buy >CUT units, they pay low price (LP) per unit. CUT 

is simply the “cutoff  point at which the charged price changes.” For example, 

if customers buy ≤1000 units, you charge $10 a unit, but if they buy more 

than 1000 units, you charge $8 per unit for all units bought. This form of 

nonlinear pricing is called the nonstandard quantity discount. Another type of 

quantity discount strategy is as follows: Charge HP for the fi rst CUT units 

bought, and charge LP for remaining units bought. For example, you charge 

$10 per unit for fi rst 1000 units and $8 per unit for remaining units bought. 

This form of nonlinear pricing is called the standard quantity discount. In both 

examples the value of CUT = 1000. 

 ■ Two-part tariff : The cost of buying q units is a fi xed charge K plus $c per 

unit purchased. For example, it may cost $500 to join a golf club and $30 

per round of golf.

Many companies use quantity discounts and two-part tariff s. Microsoft does not 

charge twice as much for 200 units, for example, as for 100 units. Supermarkets 

charge less per ounce for a 2-pound jar of peanut butter as for a 1-pound jar of peanut 

butter. Golf courses often use a two-part tariff  by charging an annual membership 

fee and a charge for each round of golf.

Just as in Chapter 5 you used the Evolutionary Solver to fi nd optimal price bun-

dling strategies, you can use the Evolutionary Solver to fi nd the profi t maximizing 

parameters of a nonlinear pricing strategy. As in Chapter 5, you can assume the 

Nonlinear Pricing
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follows: All units up to a value CUT are sold at a high price (HP). Recall that 

CUT is simply the cutoff  point at which the per unit price is lowered. All other 

units sell at a lower price (LP). Assuming the customer chooses the number 

of kwh with the highest non-negative surplus, you can use the Evolutionary 

Solver to determine profi t maximizing values of CUT, HP, and LP. The work for 

this task is shown in sheet qd of file Powerblockprice.xls. Also, Figure 6-2 

shows that the demand curve may be written as p = 10 – (q/2), so the first 

unit is valued at 10 – (.5/2) = $9.75, the second unit is valued at 10 – (1.5/2) = 

$9.25, and so on. 

Figure 6-2: Finding the profi t maximizing standard quantity discount strategy

To complete the determination of the profi t maximizing standard quantity dis-

count strategy, complete the following steps: 

 1. Copy the formula =10-0.5*C6 from E6 to E7:E25 to determine the value of 

each unit.

 2. In column F compute the cumulative value associated with buying 1, 2,…19 

units. In F6 compute the value of the fi rst unit with formula =E6. Copy the 

formula =F6+E7 from F7 to F8:F25 to compute the cumulative value of buying 

2, 3,…20 units.
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 3. Copy the formula =IF(D6<=cutoff,HP*D6,HP*cutoff+LP*(D6-cutoff)) from 

G6 to G7:G25 to compute the total cost the consumer pays for purchasing 

each number of units. If you want to analyze diff erent nonlinear pricing 

strategies, just change this column to a formula that computes the price the 

customer is charged for each number of units purchased.

 4. Copy the formula =F6-G6 from H6 to H7:H25 to compute the consumer sur-

plus associated with each purchase quantity. In cell H4 compute the maxi-

mum surplus with the formula =IF(MAX(H6:H25)>= 0,MAX(H6:H25),0); if it 

is negative no units will be bought, and in this case you enter a surplus of 0.

 5. In cell I1 use the match function to compute the number of units bought with 

the function =IF(H4>0,MATCH(H4,H6:H25,0),0).

 6. In cell I2 compute the sales revenue with the formula =IF(I1=0,0,VLOOKUP

(I1,lookup,4)). The range D5:G25 is named Lookup.

 7. In cell I3 compute production cost with the formula =I1*C3.

 8. In cell J6 compute profi t with the formula =I2-I3.

 9. Use Solver to fi nd the values of CUT, HP, and LP that maximize profi t. The 

Solver window is shown in Figure 6-3.

You can constrain the value of CUT and each price to be at most $20. To do 

so, charge $14.30 per unit for the first 5 units and $2.22 for remaining units. 

A total profi t of $64 is earned. The quantity discount pricing structure here is an 

incentive for the customer to purchase 16 units, whereas linear pricing results in 

the customer purchasing only 6 units. After all, how can the customer stop at 6 

units when later units are so inexpensive?

Optimizing the Nonstandard Quantity Discounts
Now assume that your quantity discount strategy is to charge a high price 

(HP) if at most CUT units are purchased, and if more than CUT units are pur-

chased, all units are sold at a low price (LP). The only change needed to solve 

for the profi t maximizing strategy of this form (see sheet qd2) is to copy the for-

mula =IF(D6<=cutoff,HP*D6,LP*D6) from G6 to G7:G25. Then just rerun the 

Solver window, as shown in Figure 6-3. This pricing strategy, shown in Figure 

6-4, maximizes the profi t: If the customer buys up to 15 units, he pays $16.79, 

and if he buys at least 16 units, he pays $6 per unit. Then the customer buys 

16 units, and you make $64 in profi t.
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Figure 6-3: Determining the profi t maximizing standard quantity discount

Figure 6-4: Profi t maximizing nonstandard quantity discount
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Optimizing a Two-Part Tariff
Organizations such as a golf country club or Sam’s Club fi nd it convenient to give the 

consumer an incentive to purchase many units of a product by charging a fi xed fee 

to purchase any number of units combined with a low constant per unit cost. This 

method of nonlinear pricing is called a two-part tariff . To justify paying the fi xed 

fee the customer needs to buy many units. Of course, the customer will not buy any 

units whose unit cost exceeds the consumer’s reservation price, so the organization 

must be careful to not charge a unit price that is too high. 

For example, when you join a country club, you often pay a fi xed fee for joining 

and then a constant fee per round of golf. You might pay a $500 per year fi xed fee 

to be a club member and also pay $30 per round of golf. Therefore one round of golf 

would cost $530 and two rounds of golf would cost $560. If a two-part tariff  were 

linear then for any number of purchased units, the cost per unit would be the same, 

but because one round cost $530 per round and two rounds costs $530/2 = $265, the 

two-part tariff  is not consistent with linear pricing. 

To dig a little deeper into the concept of a two-part tariff , look at the worksheet 

tpt. You will see how a power company can optimize a two-part tariff  by perform-

ing the following steps:

 1. To begin, make a copy of your QD or QD2 worksheet. 

 2. In F2 enter a trial value for the fi xed fee, and in F3 enter a trial value for the 

price per unit. Name cell F2 Fixed and cell F3 var. The only formulas that 

you need to change are the formulas in the Price Paid formula in Column G 

(see Figure 6-5). 

 3. Copy the formula =Fixed+D6*Var from G6 to G7:G25, to compute the cost 

of buying each number of units. 

 4. Adjust the Solver window, as shown in Figure 6-6.

You need to constrain the fi xed and variable costs between $0 and $100. The profi t 

is maximized by charging a fi xed fee of $60.27 and a cost of $2.21 per unit. Again 

a maximum profi t of $64 is made, and the customer purchases 16 units.
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Figure 6-5: Optimizing a two-part tariff

Figure 6-6: Solver window for two-part tariff







Nonlinear Pricing 133

   

Figure 6-7: Data for Problem 4

 a. If you charge a single price for each song, what price can maximize 

your revenue?

 b. If you use a two-part tariff  pricing scheme (for example $3 to download 

any songs + 40 cents per song), how can you maximize revenue?

 c. How much more money do you make with the two-part tariff ?

NOTE For the second part, you must realize that a person will buy either noth-

ing, their top-valued song, their top 2 songs, their top 3 songs,…their top 9 songs 

or top 10 songs.

 5. Show that for the demand curve q = 40 – 2p the consumer places a value of 

exactly $256 on the fi rst 16 units.

 6. (Requires calculus) Suppose the demand for a computer by a leading corpo-

rate client (for p≥100) is given by 200000 / p2. Assume the cost of producing 

a computer is $100. 

 a. If the same price is charged for each computer, what price maximizes 

profi t?

 b. If you charge HP for the fi rst CUT computers and LP for remaining 

computers purchased, how can you maximize profi t?
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 7. Suppose Verizon has only three cell phone customers. The demand curve for 

each customer’s monthly demand (in hours) is shown here: 

Customer Demand curve

1 Q = 60 – 20p

2 Q = 70 – 30p

3 Q = 50 – 8p

Here p = price in dollars charged for each hour of cell phone usage. It costs 

Verizon 25 cents to provide each hour of cell phone usage.

 a. If Verizon charges the same price for each hour of cell phone usage, 

what price should they charge?

 b. Find the profi t maximizing a two-part tariff  for Verizon. How much 

does the best two-part tariff  increase the profi t over the profi t maximiz-

ing the single price? 

 8. For the power company example construct a standard quantity discount pric-

ing strategy that leaves the customer with 25 percent of the consumer surplus. 
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